Digital Oscilloscope & Multimeter

B 4% &1 # #} 886-3-5753170
JEHE J7 B (ki) 86-21-34970699
Jik 4 h L (5 4I) 86-755-83298787

Http://www. 100y. com. tw

GDS-122

USER MANUAL

GW INSTEK PART NO.

October 2007 edition

This manual contains proprietary information, which is protected by
copyrights. All rights are reserved. No part of this manual may be
photocopied, reproduced or translated to another language without
prior written consent of Good Will company.

The information in this manual was correct at the time of printing.

However, Good Will continues to improve products and reserves the
ﬁ rights to change specification, equipment, and maintenance procedures
|

1SO-9001 CERTIFIED MANUFACTURER at any time without notice.
GUINSTEK

Windows is a registered trademark of Microsoft Corporation in the United States and other countries.

Good Will Instrument Co., Ltd.
No. 7-1, Jhongsing Rd., Tucheng City, Taipei County 236, Taiwan.


User
新建印章


GUWINSTEK TABLE OF CONTENTS

TABLE OF CONTENTS

B 4% 1 # # 886-3-5753170
Jik: 4 17 LT (i) 86-21-34970699

GUYINSTEK GDS-122 User Manual
Viewing waveforms in X-Y format......cccccceeveviivrrinnnnnnnn. 47
Viewing signal peaks .......ccoooeiiiiiiiiiiiii e 48
Viewing Noisy Signals......c.ooeieemiiiieiiierereee e 49
Viewing variations in a signal...........cccevvvvuiieniiieeinnnnnnnn. 50
Calibration ..o 51
Running the self calibration ..........ccccvvveieieiiiiriiiiiieienes 51
Running the probe calibration...............ceeeeiiiiiiieieieeenens 52
Saving/Recalling Waves and Settings ...........ccceevenne.. 53
Recalling the default settings ......c.ceeveieiiiiieiieiiiiiieieienes 53
Saving Waveforms ..o e 54
Recalling waveforms .......couuuuiiiiiiiiiiiicee e 55
Menu Tree / Operation Shortcuts .......ccceviiiiiiiiiiina. 56
T = PN 56
(O I O 7Y U o L 56
Measurement Setup 1/2 ... 57
Wave Math ... 57
Cursor Measuremen ... .ccuu e eeeuueeeiiee et e e eee e 57
ACQUISITION MOAE ..cveeeieieeieieicee e 58
TIimMe MOE...ccuiiiiiie e 58
FUNCTION e 58
(D110 F= VU 58
WAV SAVE ...ttt 59
SYSTEM STATUS oeeeiieiiiie et 59
OSC OPTION KEY ..ieeviiieeiieeeiie e et e e eeie e e e e e eeaans 60
Using the Software ......coviiiiiii e 61
Installing the software ........cccceeeeeviieiiiicieeeeeeeeeecee e 62

Modifying/Reinstalling/Uninstalling the software......... 64

Safety INStructions.......ccvvvciiiiiiiriiiiciceeer e, 6
Getting Started.....ccoooiiiiiiii e 9
Package Contents ....coiiiiiiiiiiiii i 10
Main FEatUIeS .o 11
Front Panel and Keys Overview .........cccovviiviiiieinnnnns. 12
Manual OVErVIEW ..co.eieiiiiii e e 14
Using the Oscilloscope......ccoiiiiiiiieicinnnnns 15
Basic Operations . iiiie i i e e 16
1. Powering up the GDS-122...c..uuiiiiiieieiiiiiee e 16
2. Connecting an input signal .........cceevieiiiiiiiiiiiecennns 17
3. Using the Autoset function......cccccceevvvveeiiiiciineeeeeennn. 18
4. Introducing the display contents ..........cccceeveueieeenenns 19
5. Adjusting waveform scales.........cooeeeeririeiiiiiiiiieienenens 20
6. Adjusting waveform positions..........cccceeeeveririiiinnnen. 21
Configurations ...ooeiivi i 22
Configuring channel (vertical) settings .........cccuuvueeeenenes 22
Configuring horizontal settings.......ccuuuveieviieeiieniiennenns 25
Configuring trigger settings: general settings .............. 27
Configuring trigger settings: edge triggering
Configuring trigger settings: video triggering .............. 3
Selecting the acquisition mode.........ccccceeviiiiriiiiiinnnnnns 3
Configuring display settings ........ccooeeiiiiiiiiiiiiiiieeee. 3
Viewing the System StatUS.......ccoveeerermmeuiiereeerernniineeeees 3
MeEaSUIreMENTS .ot aaees 3
Running waveform maths.........cccccceeeeeiiiiieiiiicecc e, 39
Running automatic measurements ..........ccceeeuveenneennnnnn. 41
Running time cursor measurements........cccoeeuuveenneennnnen. 42
Running voltage cursor measurements ...........ccceeeeeeees 43
Advanced VIieWings ....ccooiiiiiiiiiiiii i 45
Zooming waveforms horizontally ..........ccoooveieiiiiininnnnn. 45

Activating the software and connecting the GDS-122 .. 65

Configuring the SCreen ..........ueueeeeeeeieieeeiieeeiieeeeeeeeeeeeees 68

Viewing the waveforms .........ccouvveeiieeeeeeiicceee e, 71

A4S J) HL-F- (55 01) 86-755-83298787 [ Using the cUrsor Measurements . ......o..e.eeeeevereeeeereeeeen. 75
www. 100y. com. tw Saving waveforms ..o 77

Recalling waveforms ..........eeeeveeeeeeeeeemeeeeeeeeeeeeeeeeeeeeeeeees 79

Printing out waveforms ...........cucueviieiiieiiiiieeeeeeeeeeeeeeeeens 80

Accessing the Help ..o 82

Using the Multimeter.......cccoiiiiiiiiiiieen. 83

Activating the Multimeter .......cccoiiiiiiiiiiii e 84


User
新建印章


GYINSTEK

TABLE OF CONTENTS

Measuring Voltage ...cooiuiiiieiiii e 85
Measuring CUrrent . ..o eeeae e 87
Measuring Impedance .....ocoviiiiiiiiiiii e 89
Measuring Diode ..cocoviiiiiiiiici 91
Measuring CONtiNUITY «.ovviieiiiii e e 92
Measuring CapacCitanCe ...ccvoevieiiieiii i eaeeaeenens 93
- Lo [ 95
Specifications...c.ccviiiiiiiiii i 97

Oscilloscope specifications ........cccevueeeiiiiiieeiiieeeceieeee, 97

Multimeter specifications ........cccoevveeiiiiiiiiiiiieeiieeeeene, 98

General specifications .......ccevueeerieeieeiieee e 99
Declaration of Conformity.........ccoccvvevnnnane. 100
T L= PP 101

B 4 A # 3 886-3-5753170
W4 B~ (i) 86-21-34970699
J: 4% 7 WL (5 9)1) 86-755-83298787

Http://www. 100y. com. tw

GUWINSTEK GDS-122 User Manual

SAFETY INSTRUCTIONS

Safety Symbols

This chapter contains important safety instructions
that you should follow when operating the
instrument and when keeping it in storage. Read
the following before any operation to ensure your
safety and to keep the instrument in best condition.

These symbols may appear in this manual or on the instrument.

& WARNING

Warning: Identifies conditions or practices that
could result in injury or loss of life.

& CAUTION

Caution: Identifies conditions or practices that
could result in damage to the instrument or to
other properties.

DANGER: High Voltage

Attention: Refer to the Manual

Protective Conductor Terminal

- [®[>>

Safety Guidelines

Earth (ground) Terminal

General
Guidelines

& CAUTION

o Do not place heavy objects on the instrument.

« Avoid severe impacts or rough handlings that
may damage the instrument.

o Avoid discharges of static electricity onto or
near the instrument.

» Do not insert bare wires or metal objects into
the terminals.

« Do not apply input voltage more than 42V
peak (30Vrms) to the instrument.
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Safety Instructions

Do not perform measurements at a power
generating source or building installation site
(see note below).

The instrument should only be disassembled
by a qualified technician.

(Measurement categories) EN 61010-1:2001 specifies the measurement
categories and their requirements as follows. This instrument falls under
category |. Measurement category IV is for measurement performed at
the source of low-voltage installation. Measurement category Il is for
measurement performed in the building installation. Measurement
category Il is for measurement performed on the circuits directly
connected to the low voltage installation. Measurement category | is for
measurements performed on circuits not directly connected to Mains.

Power Supply

& WARNING

AC Input voltage: 100 to 240V, 50/60Hz

The power supply voltage should not fluctuate
more than 10%.

Always use the AC adaptor included in the
package.

Always connect the AC adaptor to the mains
line first, then to the instrument.

Cleaning the
instrument

Disconnect the power cord before cleaning the
instrument.

Use a soft cloth dampened in a solution of mild
detergent and water. Do not spray liquid into
the instrument.

Do not use chemicals or cleaners containing
harsh products such as benzene, toluene,
xylene, and acetone.

Operation
Environment

Location: Indoor, no direct sunlight, dust free,
most non-conductive pollution (see note below)

Relative Humidity: < 75%
Altitude: <2000m
Temperature: 0°C to 40°C

(Pollution Degree) EN 61010-1:2001 specifies the pollution degrees and
their requirements as follows. This instrument falls under degree 2.
Pollution refers to “addition of foreign matter, solid, liquid, or gaseous
(ionized gases), that may produce a reduction of dielectric strength or
surface resistivity”.

Pollution degree 1: No pollution or only dry, non-conductive pollution
occurs. The pollution has no influence.

Pollution degree 2: Normally only non-conductive pollution occurs.

GUWINSTEK GDS-122 User Manual

Occasionally, however, a temporary conductivity caused by condensation
must be expected.

Pollution degree 3: Conductive pollution occurs, or dry, non-conductive
pollution occurs which becomes conductive due to condensation which
is expected. In such conditions, equipment is normally protected against
exposure to direct sunlight, precipitation, and full wind pressure, but
neither temperature nor humidity is controlled.

Storage ¢ Location: Indoor
envirgpment o Relative Humidity: < 75%

o Temperature: -10°C to 70°C

Power cord for the United Kingdom

When using the instrument in the United Kingdom, make sure the
power cord meets the following safety instructions.

NOTE: This lead/appliance must only be wired by competent persons

&WARNING: THIS APPLIANCE MUST BE EARTHED
IMPORTANT: The wires in this lead are coloured in accordance with the following code:

Green/ Yellow: Earth
Blue: Neutral
Brown: Live (Phase)

As the colours of the wires in main leads may not correspond with the colours marking identified in
your plug/appliance, proceed as follows:
The wire which is coloured Green & Yellow must be connected to the Earth terminal marked with the

letter E or by the earth symbol @ or coloured Green or Green & Yellow.

The wire which is coloured Blue must be connected to the terminal which is marked with the letter N or
coloured Blue or Black.

The wire which is coloured Brown must be connected to the terminal marked with the letter L or P or
coloured Brown or Red.

If in doubt, consult the instructions provided with the equipment or contact the supplier.

This cable/appliance should be protected by a suitably rated and approved HBC mains fuse: refer to the
rating information on the equipment and/or user instructions for details. As a guide, cable of 0.75mm2
should be protected by a 3A or 5A fuse. Larger conductors would normally require 13A types,
depending on the connection method used.

Any moulded mains connector that requires removal /replacement must be destroyed by removal of any
fuse & fuse carrier and disposed of immediately, as a plug with bared wires is hazardous if a engaged in
live socket. Any re-wiring must be carried out in accordance with the information detailed on this label.
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Getting Started

GETTING STARTED

This chapter gives you an overview of what the
GDS-122 is about, what items are included in the
package, and how the user manual is organized.
After opening the GDS-122 package, check the
contents referring to the Package Contents section,
then learn the features and interface reading the
Main Features and Front Panel and Keys Overview
section. The Manual Overview section gives you
an overall picture of what each chapter is about,
helping you directly jump to the relevant location.

‘oo 122]

|

=iy
|

]
=

IS

A
Package Contents ...oooiieiiiiiiiii i 10
Main FEatUIeS . e 11
Front Panel and Keys OVerview ........cccoviviiiiiiinnnnnsn. 12
Manual OVErVIEW ..ovuiieiiiiii e 14
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Package Contents

GDS-122 User Manual

Soft carrying case

GDS-122

AC-DC adaptor

Oscilloscope probe x 2 + probe
adjustment tools

\ed

1kHz square wave output cable

Al .

Multimeter test lead x 2

Extension module for large
current measurement

Extension module for small
capacitance measurement

USB communication cable

CD-ROM
(software)

User Manual

(this document)

RS-232C communication cable

(optional item - contact Good
will)

10
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Main Features

Oscilloscope

Dual channel

20MHz bandwidth

100MS/s real-time sampling rate
< 17.5ns rising time

5ns to 5s/div horizontal scale
5mV to 5V/div vertical scale

6k memory points per channel

Isolated inputs between oscilloscope and
multimeter

Autoset function

Trigger mode: Auto, Free run, Single shot,
Edge, Video

2 cursors

5 automatic measurements
4 display image memories
Auto-calibration

Multimeter

Volts, Amps, Ohms, Continuity, Diode,
Capacitance measurement

20A maximum amplitude
True RMS measurement

Isolated inputs between oscilloscope and
multimeter

Common

USB interface

RS-232C interface

1kHz square wave output

3.8 inch color LCD display, 320 x 240 resolution
6 hours running time Li-ion battery

180mm x 113mm x 40mm compact size

690g light weight

B 4% H # ¥ 886-3-5753170
JUk 4% ) WL F (i) 86-21-34970699
JHE 4% 17 HL - (5 1) 86-755-83298787
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Front Panel and Keys Overview

AC adaptor
plug

Display
contrast
switch

F1 - F5 keys

Power
switch

A switch
V switch
R switch

mA
terminal

USB/RS-232C/Square wave port

1 [

GD8-123]

i LCD
NN : display
; S\
OSC OPTION key
+ Arrow keys
_A

MENU key +
Up/Down keys

RUN/STOP key
AUTOSET key
DMM/OSC key

Oscilloscope
CH1/CH2
terminal

COM V/Ohm CX
terminal terminal terminal

: Oscilloscope function : Multimeter function

AC adaptor plug

Accepts the AC adaptor cord. DC 8.5V, 1500mA.

USB port

Accepts the USB cable for PC connection.

RS-232C port

Accepts the optional RS-232C cable for PC
connection.

Square wave
output

Outputs a 1kHz square wave for probe
compensation and other general purposes.

LCD display

3.8 inch, 320 x 240 resolution, color LCD display.

OSC OPTION key Sets the following parameters: vertical

+ Arrow keys

level and scale (page22), horizontal level
and scale (page25), trigger level (page25),
and cursor position (page42).

12
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MENU key +
Up/Down keys

Activates the side menu and selects the
menu items.

RUN/STOP key

Manually turns on (run) or off (stop) the
trigger. For details, see page25.

RUN/STOP key

Freezes (stop) or unfreezes (run) the
measurement.

AUTOSET key

Automatically selects the horizontal scale,
vertical scale, and trigger level according
to the input signal. See pagel8 for details.

Switches the measurement mode. For
details, see page87(current),
page85(voltage), and page89(impedance).

DMM/OSC key

Switches the operation mode between the
oscilloscope and multimeter.

CH1/2 terminal

Accepts the CH1 and CH2 input signal.

CX terminal Accepts the test leads for capacitor
measurement.

V/Q terminal Accepts the red lead for voltage, small
capacitance, and impedance
measurements.

COM terminal Accepts the black (ground) lead.

mA terminal Accepts the red lead for current
measurement.

R switch Selects the following measurement:
impedance (page89), diode (page91),
continuity (page92), capacitance (page93).

V switch Selects voltage measurements (page85).

A switch Selects current measurements (page87).

Power switch

Turns on or off the GDS-122 power.

F1 - F5 keys

Selects the menu item at the bottom of the display.

Disp contrast sw Selects the display contrast.

B 4 A # 3 886-3-5753170
W4 B~ (i) 86-21-34970699
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Manual Overview

Overview This user manual is comprised of seven chapters.
If you want to jump start using the GDS-122, go
directly to the Using Oscilloscope or Using
Multimeter chapter.

Safety The Safety Instructions gives you an overview of

Instructions important safety-related issues which you should

(pageb) be aware of before, during, and after operations.

Getting Started
(page9)

The Getting Started chapter provides you with the
overview of the GDS-122: main features, package
contents, front panel, and user manual (this
section).

Using the The Using the Oscilloscope chapter describes in

Oscilloscope detail how to use the GDS-122’s oscilloscope

(page15) functionalities, including the PC software. The
chapter starts with simple, basic operations
toward more complex measurements and settings.
If you are new to the GDS-122, start with the Basic
Operations section. For advanced users, the Menu
Tree / Shortcuts section shows the menu structures
and all operations shortcuts.

Using the The Using the Multimeter chapter describes how to

Multimeter use the GDS-122’s multimeter functionalities. The

(page83) most commonly used Voltage, Current, and
Resistance sections are listed in the front.

Faq The Faq chapter lists major problems you might

(page9s) encounter during operations and how to fix or

avoid them. Most issues are also listed in the
relevant chapters throughout the document.

Specifications
(page97)

The GDS-122 specifications are separated in
oscilloscope, multimeter, and general parts.

Declaration of

The Declaration of Conformity chapter lists the

conformity safety and EMI/EMC standards to which the GDS-
(page100) 122 conforms.

Index The Index chapter lists most of the keywords used
(pagel01) in this manual in an alphabetical order.

14
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USING THE
OSCILLOSCOPE

This chapter describes the oscilloscope
functionalities in the GDS-122: setting it up and
measuring simple waveforms, using advanced
measurement functions, and configuring the
system settings. The menu tree section at the end
gives you an overview of all functionalities and a
quick access to each of them. For the multimeter
functionalities, see page83.

Basic Operations . .c.ouveiiiii i 16
Configurations ...ooeiii i 22
MeEaSUIreMENTS . o eanees 39
Advanced VIeWIiNgs ...oouviiiiiiii i eeeeea s 45
Calibration ..o 51
Saving/Recalling Waves and Settings ..........cocevvieiinnn. 53
Menu Tree / Operation Shortcuts ........ccooceiiiiiiiin..... 56
Using the Software......cooviiiiiiii e 61
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Basic Operations

Operation flow  The Basic Operations section describes how to set
up the GDS-122 and observe an input signal, step-
by-step.

1. Powering up the GDS-122
Connecting an input signal
Using the Autoset / Introducting the display

- LN

Adjusting the scales
5. Adjusting the waveform position

Advanced For more advanced or detailed operations, see the
operations following chapters.

o Configurations (page22)

e Measurements (page39)

o Advanced Viewings (page45)
o Calibrations (pagebl)

1. Powering up the GDS-122

1. Pressing the  Press the power switch. The welcome
power switch screen with the corporate logo
appears on the display.

Mads 1o Massurs

GDS5-122
Handheld (igital Storage Onclloscope & Multimeter

Press any key to continue.

the switch on the side. The backlight

To adjust the display brightness, press =
turns on and off. =

2. Activating the Press any key (for example the MENU (Example)
oscilloscope  key) to enter the oscilloscope mode.
See the battery level icon at the top left
corner of the display and connect the

16
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power cord if the level is < 25%.

> 75% 75% 50% 25% < 25%

Switching the  If the multimeter screen appears,

operation mode press the DMM/OSC key and change
the mode to oscilloscope.

Tilt standing the Use the bar at the back to
GDS-122 tilt stand the GDS-122 on a
horizontal plane.

Note If pressing the power switch does not turn on the
GDS-122, the battery may need recharging.
Connect the GDS-122 to the AC adaptor and
recharge it for at least 15 minutes.

2. Connecting an input signal

1. Connecting  Connect the probe(s) between the DUT (Device
the probe Under Test) and the CH1/2 inputs on the GDS-122.

Alternately, you may use the
GDS-122's own 1kHz square
X

wave output signal. Insert the
signal cable (included in the
package) to the output terminal.

TR

GUWINSTEK GDS-122 User Manual

wave

=2 _ DUT or
< 52 X1 X10 1kHz square

3. Setting the 1. After attenuating the probe level by x10, you
display also need to magnify the display level by x10
magpnification to match the displayed amplitude with the real

amplitude. Open the CH1 or CH2 SETUP
menu by pressing the MENU key and using
the Up/Down keys.

2. Select the probe attenuation level (10X) by
pressing F3 (Probe) repeatedly. The CH1/CH2
vertical scale indicator at the bottom left corner
of the display changes accordingly.

CH1 SETUP T0X
MENU)—> Prob
CH2 SETUP roke

3. Using the Autoset function

2. Setting the To prevent excessive input voltage, we
probe recommend you to set the probe attenuation level
attenuation  to the X 10 position to prevent excessive voltage.

B 4% H # # 886-3-5753170
JEHE J7 B (ki) 86-21-34970699
4% ) HL - () 86-755-83298787 17
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Overview The Autoset function automatically configures the
following parameters according to the input
signal.

« CH1/CH2 on/off
o Vertical scale/level
« Horizontal scale/level

o Trigger level

Using the Press the AUTOSET key. The input

Autoset function signal appears in the best display

condition.

(Continued on next page)

18
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5. Adjusting waveform scales
Example

Before After Selecting the Press the OSC OPTION key
menu repeatedly until the following 5

menu appears on the display. D & (I

<4/ _ Time Base

A /Y _CH1 (or CH2) Volts/Div

'1$F'ET‘iI:'IIE' B‘ﬂ.SE:

AsY —CH1 Uolts/T ;
CH1 Z0m-

Vertical scale Horizontal scale

4. Introducing the display contents
Adjusting the  Use the Left/Right key to change the horizontal

horizontal scale scale.

Frequency / 0 000 Trigger status
channel off
Horizontal Original
S — center
SR SR [T S IR RN position

s 3% Trigger level
Vertical : : : : :
center =®foriv bl b
position e £ £ 8 & & & &8 £ ;¢

Horizontal
scale

TR R R Adjusting the  Use the Up/Down key to change the vertical scale.
AP =Tine Base i vertical scale

As¥ CHZ U s 3 Vartical U
Vertical scale center

position

Trigger status  « Updating the signal (auto mode) ()

o The signal is triggered [ Trig’d |
+ Waiting for trigger conditions ()
o Triggering is stopped

Press the RUN/STOP key to control

trigger on/off (run/stop).

B 4% H # # 886-3-5753170
JEHE J7 B (ki) 86-21-34970699
4% 1 LT (3 9I) 86-755-83298787
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6. Adjusting waveform positions

Selecting the
menu

Press the OSC OPTION key

repeatedly until the following @
menu appears on the display. D(I
</» _ Time D

A /Y _CH1 (or CH2) Zero

Horizontal
center
position

Vertical —pf
center : c c c c E <
position —

Adjusting the
horizontal
position

Use the Left/Right key to change the horizontal
position.

Original

Adjusting the
vertical position

Use the Up/Down key to change the vertical
position.

@ Original D

GYINSTEK GDS-122 User Manual
Configurations
Overview The configuration chapter describes how to

change various GDS-122 internal parameters for
allowing better measurement condition.

Configuration ~ « Channel (vertical) settings page22
iperns o Horizontal settings page25
o Trigger settings page25
e Acquisition modes page30
» Display settings page36

o System status (only for viewing) page37

Configuring channel (vertical) settings

Overview The channel settings configure how the waveform
appears in terms of vertical or voltage scale.

Position  Sets the vertical position of the
waveform.

Scale Sets the vertical scale (volts per
graticule). Range: 5mV/div to 5V/div

CH on/off Turns the channel on or off.

Coupling Selects AC or DC coupling. The DC
coupling shows all signal elements,
while the AC coupling filters out the
DC component from the waveform.

Inversion Flips the waveform upside down.

Magnifica Magnifies the displayed units (does not

-tion magnify the real signal). The
magnification function is useful to
align the displayed with probe
attenuation (pagel?), especially X10.

B 4% H # # 886-3-5753170
JEHE J7 B (ki) 86-21-34970699
Jik 4 h BG4I 86-755-83298787
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Setting the 1. Press the OSC OPTION key

vertical position repeatedly until the following —
menu appears on the display. D OPTIO (l
< — Time

A /Y _CH]1 (or CH2) Zero

. Use the Up/Down key to change the vertical

position.

Setting the 1.

vertical scale

Press the OSC OPTION key

repeatedly until the following w
menu appears on the display. D(l
</» _Time Base

A/Y _CHI (or2)VoltsDiv. /. \

/P “Tine Base
A¥ —CHZ Ualts/D
CH1 20m- 2

. Use the Up/Down key to change the vertical

scale.

G Original D
Ve

Turning the 1.

channel on/off

Press the MENU key and use the Up/Down
keys to select the CH1(CH2) SETUP menu.

Press F2 (Channel) repeatedly to turn on or off
the channel.

Bk 4% 4 # 4 886-3-5753170
W4 B~ (i) 86-21-34970699
J: 4% 7 WL (5 9)1) 86-755-83298787
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Q OFF
H1 SETUP

(o)
CH2 SETUP Channel

0/

Note that when using the Autoset function
(pagel8), channels are automatically turned on or
off.

Selecting the
coupling mode

1. Press the MENU key and use the Up/Down
keys to select the CH1(CH2) SETUP menu.

2. Press F1 (Coupling) repeatedly to select DC,
AC, or Ground coupling.

DC
Ground

CH1 SETUP
D
crz seTup | Leoupling

The DC coupling shows both DC and AC
signal.

O>
i:

The AC coupling only shows the AC signal.
The Ground coupling shows the ground line.

DC coupling

(center point is at the ; : :
bottom due to DC SRR R o e
offset) : : '

VU e

AC coupling

(center point is at the : :
middle since the DC |, ,ivvii|iiiiivi,
offset is being : :

removed)

Inverting the
channel

24

1. Press the MENU key and use the Up/Down
keys to select the CH1(CH2) SETUP menu.

2. Press F4 (Inverted) to invert the waveform.
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A o
(o ——>
CH2 SETUP Inverted
0/
Invert off Invert on
ey - .

Selecting the

1. Press the MENU key and use the Up/Down

magnification keys to select the CH1(CH2) SETUP menu.

2. Press I3 (Probe) repeatedly to select the probe
magnification ratio.
1000 X

100 X
10 X

CH1 SETUP
U l CH2 SETUP I Probe

G

Configuring horizontal settings

Overview The horizontal settings configure how the
waveform appears in terms of horizontal or time
scale.

Position ~ Sets the horizontal position of the
waveform.

Scale Sets the horizontal scale (time per
graticule). Range: 100ms/s to 10s/s

Setting the 1. Press the OSC OPTION key

horizontal repeatedly until the following

position menu appears on the display. D(I

<4/» _Time

25
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2. Use the Left/Right key to change the horizontal
position.

Original

Selecting the
horizontal scale

26

1. Press the OSC OPTION key

<4/» _ Time Base
4P “Tihe Basé -

F Yo i

repeatedly until the following =
menu appears on the display. )(I

2. Use the Left/Right key to change the horizontal
scale.

Original (I

B 4% H # # 886-3-5753170
W4 B~ (i) 86-21-34970699
JE 4 b HL P (5 4) 86-755-83298787

Http://www. 100y. com. tw
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Configuring trigger settings: general settings

Overview

The trigger settings configure how the incoming
signal is triggered. The general settings section
describes how to start and stop triggering, adjust
the level, and change the trigger mode.

» For edge triggering details, see page30.
» For video triggering details, see page33.

GYINSTEK

GDS-122 User Manual

triggering, you have to press the

RUN/STOP key again (in single trigger

mode) or switch to another trigger mode.
Horizontal scale vs. trigger status

Sns/div 100ms/div 5s/div

=

i

Status Shows the triggering status in the icon
appearing in the upper right corner of
the display.
Run/Stop Controls starting and stopping the Run/Stop Pressing the Run/ Stop kgy once stops
trigger. triggering at most situations and
changes the trigger icon to STOP.
Level Adjusts the vertical and horizontal ) ] . . ]
level on which the waveforms are In the single trigger mode in edge triggering
triggered. (page30), pressing the RUN/STOP key works as
both activating and deactivating trigger.
Trigger status ~ The trigger status icon is located at the top right
corner of the display. Trigger level Press the OSC OPTION key %
repeatedly until the following menu 0
(0 The trigger condition is met. appears on the display.
(1) The GDS-122 is showing the input signal <4/P _ Time
waveform regardless of trigger A/V _ Trig
condition. Available in the Auto trigger
mode in edge triggering (page30). Trigger level indicators
T The trigger condition is not met, and the Trigger level
GDS-122 is waiting for the next (horizontal)
condition. Available in the Normal ciz orr HREERRE
trigger mode in edge triggering (page30). A A :
@) The GDS-122 is showing the input signal
waveform regardless of trigger
condition. The waveform is gradually
updated from the left side of the display. : - < i
The GDS-122 automatically switchesto g ] Tr('gget.r 'el‘)’e'
the Scan when the horizontal scale is at vertica
100ms/div or longer.
Triggering is stopped regardless of the
trigger condition. In order to restart BE 4% H # # 886-3-5753170
JE 4 ) WL F- (1) 86-21-34970699
27 28 JE 4% ) HL T (591 86-755-83298787

Http://www. 100y. com. tw
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Use the arrow keys to change the triggering
position.

Move the trigger
point up

Move the : : Move the
trigger point trigger point
left right

Move the trigger
point down

Pressing the Up and Down G.F D

key together resets the
vertical trigger level to zero.

Pressing the Left and Right
key together resets the
horizontal trigger level to
Zero.

Bk 4% 4 # 4 886-3-5753170
W4 B~ (i) 86-21-34970699
J: 4% 7 WL (5 9)1) 86-755-83298787

Http://www. 100y. com. tw
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Configuring trigger settings: edge triggering

Overview The edge trigger type triggers on the incoming
signal edge. Use the edge trigger for all signals
except for video related ones.

o For general trigger settings, see page27.
» For video triggering details, see page33.

To select edge triggering, follow these steps.

1. Press the MENU key and use the Up/Down
keys to select TRIG MODE menu.

2. Press F1 (Type) to select the Edge trigger type.

Edge
TRIG MODE TYPE

SOP

Slope Selects the slope, rising or falling, on
which the GDS-122 triggers the input
signals.

Source Selects the signal source channel,
CH1 or CH2.

Mode Selects the triggering mode, Auto

(acquires signal continuously),
Normal (acquires signal when trigger
conditions are met), and Single
(manually triggers the signal).

Coupling  Selects the DC or AC coupling and
rejection filters: high frequency or
low frequency.

Selecting the Press F2 (Slope) repeatedly to Rising
trigger slope select the rising or falling slope.
Slope

(Continues to the next page)

30
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Normal mode

Example: falling edge In the normal mode, input signals are shown in
Falling edge Triggering point the display only if the trigger condition is met.
Horizontal scale (/div) S5ns 100ms 5s
CHz. OFF _'f 1.000KHZ Status icon when triggered

[ Trig’d il Scan ]
Status icon when not triggeredi (___ Ji(_ )

Single mode

In the single mode, you manually trigger the GDS-
122 by pressing the RUN/STOP key each time you
need to observe the waveform. Once the waveform
is captured, the GDS-122 stops triggering and
waits for the next trigger command.

Horizontal le (/di 5 100 5
Selecting the Press F3 (Channel) repeatedly to select CH2 2gpntal scale (dk s m °

source channel the trigger source channel, CH1 or o Status icon when triggered
CH2. The trigger channel indicator at saiftce

the bottom right corner of the display

changes. Status icon when not triggered  Scan

Trigger source, ‘

Selecting the Press F5 (Coupling) repeatedly to select AC

h I '
channe — coupling mode  the trigger coupling. I'_-"; F:{in
Selecting the Press F4 (Mode) repeatedly to select Auto o AC: triggers only on the AC portion
trigger mode the trigger mode. The trigger status Normal of the waveform.
icon in the upper right corner of the Single X e
display changes accordingly. For the EACC t:‘%%e;rs Oft the whole waveform
overview of trigger status in general, :
see page27. o LF Rjc: filters out the lower
frequency when triggering.
Auto mode

» HF Rjc: filters out the higher
In the auto mode, input signals are constantly frequency when triggering.
acquired and shown in the display regardless of

trigger condition.

Horizontal scale (/div) 5ns 100ms 5s

Status icon when not triggered

Status icon when triggered [ Trig’d Bl Scan |
_AUTO || Scan |

B 4 A # 3 886-3-5753170
W4 B~ (i) 86-21-34970699
J: 4% 7 WL (5 9)1) 86-755-83298787

Http://www. 100y. com. tw
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Configuring trigger settings: video triggering

Overview

The video trigger type is designed to capture the
video signal format, NTSC, PAL, or SECAM. For
any other signal type, use the edge trigger.

o For general trigger settings, see page27.
» For edge triggering details, see page30.

To select edge triggering, follow these steps.

1. Press the MENU key and use the Up/Down
keys to select TRIG MODE menu.

2. Press F1 (Type) to select the video trigger type.

Video
TRIG MODE

SOP

Polarity Selects the polarity of
synchronization signal. Normal
means the black level is low. Invert
means the black level is high.

Source Selects the signal source channel,
CHI1 or CH2.

Sync Selects the part of the video signal
used for synchronization: line or
field.

Selecting the
trigger polarity

Press F2 (Polarity) repeatedly to select  Inverted
the polarity of synchronization signal.
o Normal: the black level is low. Polarity
o Inverted: the black level is high.

(Continues to the next page)
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Selecting the Press F3 (Channel) repeatedly to select CH2
source channel the trigger source channel, CH1 or i
CH2. The trigger channel indicator at

the bottom right corner of the display
changes.

Trigger source, ‘
channel

N—r

Selecting the Press F4 (Polarity) repeatedly to select Field

sync the synchronization point. Tine
¢ Line: the video line is used for
triggering.
« Field: the video field is used for
triggering.
Example
Video line trigger Video field trigger

£ 666.7KHZ f 666.7KHZ [ £ 66.67KHZ | 66.67KHZ [Tzgra

TRIG MODE

TRIG MODE

B 4% H # # 886-3-5753170
Ji: 4% ) W1 (Fitp) 86-21-34970699
Ji: 4 1y HL - (3 41) 86-755-83298787
34 Http://www. 100y. com. tw
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Selecting the acquisition mode

Overview The acquisition mode specifies how the incoming
analog signal is digitally sampled by the GDS-122.

Sample The waveform data is sampled at an
equal time interval. The sample
mode accurately reconstructs the
waveform, but cannot respond to
rapid changes and sudden peaks.

Peak detect The maximum and minimum data
in the sampling interval are picked
up. The peak detect mode captures
rapid changes and sudden peaks,
but the waveform becomes noisy.

Average Multiple samples are averaged
together. The average mode reduces
the noise level, but the waveform
must be repetitive. The number of
averaging are 4, 16, 64, and 128.

Panel operations 1. Press the MENU key and Q

select the ACQU MODE
menu using the Up/Down @
keys. U

2. Select the acquisi- X Peak [
tion mode from F1 Sample | petect | Average
(Sample) to F3
(Average).
For the Average mode, also
press F4 (Averages) repeatedly  |Averages
to select the number of
averaging: 4, 16, 64, or 128.

Example Sample Peak detect Average (16)

B 4% H # # 886-3-5753170
W4 B~ (i) 86-21-34970699
JE 4 b HL P (5 4) 86-755-83298787

www. 100y. com. tw
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Configuring display settings

Overview The display settings configure how the waveforms
are drawn in the display.

vector drawing The vector drawing mode shows
the waveform as a smooth line,
connecting each data point.

dot drawing  The dot drawing mode shows the
waveform as a collection of
independent data points.

persistence The persistence setting sets how
long the old waveforms remain in
the display, useful for observing
the waveform variations.

Panel operations 1. Press the MENU key and use the Up/Down
keys to select the DISP SET menu.

2. Press F1 (Type) or F2 (Persist) repeatedly to
select vector drawing, dot drawing, and
persistence time.

Infinite
Q Dots 1/2/5 sec
| |
Vectors OFF
@ RISP SET Type ] Persist ]
0/

Vector/dot Vector Dot
drawing example N oo

Persistence Persistence off Persistence infinite

35

36


User
新建印章


GYINSTEK

Using the Oscilloscope

Viewing the system status
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GDS-122 User Manual

Vertical status (F2)

Overview The system status menu shows the GDS-122 VERTICAL SYSTEM STATUS For details of each item, see the
system settings. A o > 00V following pages.
Panel operations 1. Press the MENU key and SRR o 5000 divsco.omvy | CH1/CH2 scale: page22
select the SYS STAT menu POSITION CH2 0.00 divs(0-om) | CH1/CH2 position: %)
- position: page
[ svssTAT | COUPLING CH1 DC
using the Up/Down keys. @ COUPLING CH2 DC CH1/CH2 coupling: page22
"/ PROBE  CHL 1X
PROBE  CH2 1X CH1/CH2 probe: page22
MATH  CH1-CH2
2. Select the status menu from F1 (Horizontal) to INVERTED CH1 OFF Math mode: page39
F4 (Misc) and press it. The status information TNVERTED, CH> Q&P CH1/CH2 invert: page22
appears in the display.

Trigger status (F3): Edge trigger

TRIGGER SYSTEM STATUS

Horizontal} Vertical Trigger] Misc ’

For details of each item, see the

YPE .. EDGE following pages.
SOURCE ~ CH1 ; .

3. To close the system status Q SLOPE | ~RJVING Tr%gger fype: page30
screen, select different menus T G- S INGLE- TRARGER Trigger source: page30
using the MENU key Trigger slope: page30
followed by Up/Down keys.

U Trigger mode: page30
Trigger coupling: page30

Horizontal status (F1) Trigger status (F3): Video trigger

HORIZONTAL SYSTEM STATUS For details of each item, see the TRIGGER SYSTEM STATUS For details of each item, see the

TIME BASE wain Tive Base | following pages. TYPE  VIDEO following pages.
MAIN SCALE 1.0ms : . SOURCE  CH1 - .
WINDOW SCALE 10.us Time base: page25 poLART R NORMAL Trigger type: page33

MAIN POSITION 300.0us
WINDOW POSITION  559.60us
DISPLAY FORMAT YT
ACQUIRE MODE SAMPLE

Main/window scale: page45 SYNC LINE Trigger source: page33

Main/window position: page45 Trigger polarity: page33

Display format: page47 (XY) Trigger sync: page33

Acquire mode: page35

Misc status (F4)

The Misc status shows the serial
number and firmware version.

(Continues to the next page) MISC

Series Number

0739002
Ver 3.0
Bk 4% 4 # 4 886-3-5753170
W4 B~ (i) 86-21-34970699
J: 4% 7 WL (5 9)1) 86-755-83298787
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Measurements
Overview The advanced measurement functions allow you
to automatically measure various parameters in a
waveform.
Measurement  « Waveform math page39
items e Automatic measurements page4l
o Time cursor measurement page42
« Voltage cursor measurement page43

Running waveform maths

Overview The waveform math function runs mathematical
operations between CH1 and CH2 waveform, and
then shows the result in the display.

Math type o CHI - CH2 (subtract CH2 from CH1)
o CH2 - CHI1 (subtract CH1 from CH2)
o CHI1 +CH2 (add CH1 and CH?2)
o CH1 * CH2 (multiply CH1 and CH2)
o CH1/CH2 (divide CH1 by CH?2)

Panel operations 1. Make sure that both CH1 and CH2 waveforms
are shown in the display.

2. Press the MENU key and Q
select the WAVE MATH menu

using the Up/Down keys. @@

3. Select the math operation from F1 (CH1 -
CH2) to F5 (CH1 / CH2) and press it.

‘CH] —CH2}CH2—CH1 [cm +CH2]CH] *CHZ[CH] /CHZ]

4. The math result appears in the display
(example: adding two square waveforms)

39
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Uk 31.75mv [ 1.000KHZ

To cancel the math result, press the function
key (F1 to F5) again.

Changing the 1.

math result
position

Press the OSC OPTION key. %
0

Make sure the following menu
appears on the display.
A/V _CHM Zero i 2ALE

CH1 5.00%- CHZ2 50.Cwe—

Use the arrow keystomove the  \ [ /

math result position. D (I

Changing the 1.

math result scale

Press the OSC OPTION key
repeatedly until the following 0
menu appears on the display.

<4/P _ Time Base

A/V _CHMath
Volts/Div

Use the arrow keys to change

the math result scale. D (I

Saving or The math result waveform can be saved into or
recalling the recalled from one of the four GDS-122 internal
math result memories. See page53 for details.

40
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F5 (Cyc). Press it repeatedly to select CH1 or 2.

Running automatic measurements 7
opleft_ T

v Vp Vk
_ - corner | | X | A
Overview The automatic measurement function measures [ I I I I ]
the input signal’s characteristics and lists them in Freq | Period | Mean | PK-PK ] CycRMS
the top left corner of the display.
Source signal  CHI1, CH2 4. The measurement result appears in the top left

Measurement set SET1, SET2 cornds of the diglay-

Measurement  The following measurement items are available. Running time cursor measurements
items

o Frequency
Period Overview The time cursor function measures and updates
ero the following three types of time difference.

o Mean voltage e Between cursor 1 and cursor 2

o Peak-to-peak voltage

o Between cursor 1 and center (zero) point
o Cycle voltage (true RMS)

o Between cursor 2 and center (zero) point

Panel operations 1. Make sure that the waveform appears.

Time cursor 1. Make sure that the waveform appears.
anel operations
2. Prle sst E{l}]le IRAA%IXEJ;(E%Iland Q ¥ P 2. Press the MENU key and Q
SET2 monu using the or PheXS'sery) select the CURS MEAS menu (oo (e
i CURS MEAS
Up/Down keys. SETLand (2 using the Up/Down keys.
SET?2 correspond to the
results in the upper left
corner of the display. 3. Press F1 (Type) repeatedly to
select the Time cursor. The Type
MEASSET!  MEASSET2 cursors appear as vertical
purple lines located at the
center of the display.
Ao \ e e 4. Press the OSC OPTION key
. ..M_ MR repeatedly until the following “OPTIO
: MEAS SET2 menu appears.
<4/P» - Time -4 STime
& ¥ —Cy :
A/V _cCursor 1(or 2) il AN
| Period | Mean | PR-FR | Cyc FM3 | 5. Use the arrow keys to move the cursor or
horizontal position.
Measurement items
3. Select the measurement type from F1 (Freq) to B 4 71 # # 886-3-5753170
JE 4 ) WL F- (1) 86-21-34970699
JE4% g HLF- (5 91) 86-755-83298787
41 42
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Move the
cursor left
Move the : : Move the
horizontal horizontal
position right position left
Move the

cursor right

H i T1 TO T2
Display overview Cursor (center) Cursor
(CHT1, cursor 2)

CHZ OFF |f 1.008{HZ Trig'd

T2 - TO time
T1 -TO time
T1 -T2 time

& frequency
Cursor menu

Running voltage cursor measurements

Overview The voltage cursor function measures and updates
the following five types of voltage difference.

» Between cursor 1 and cursor 2

o Between cursor 1 and CHI1 center point
» Between cursor 2 and CH1 center point
o Between cursor 1 and CH2 center point
» Between cursor 2 and CH2 center point

Source signal CH1 input, CH2 input

Voltage cursor 1. Make sure the waveform appears.

anel operations
P P 2. Press the MENU key and Q

select the CURS MEAS menu

using the Up/Down keys. @

43
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3. Press F1 (Type) repeatedly to
select the Voltage cursor. The [_Type

cursors appear as horizontal
purple lines located at the
center of the display.

4. Press F2 (Source) repeatedly
to select the source channel. Source

5. Press the OSC OPTION key %
repeatedly until the following 0
menu appears.

<4/» _Time
A/V _Cursor V1 (or V2)

6. Use the arrow keys to move the cursor or
horizontal position.

Move the
cursor up
Move the Move the
horizontal 05 horizontal
position right O position left
Move the

cursor down

Display overview Vi V2
Splay ONg§wWe Cursor Cursor
(CH1, cursor 2)

CHZ OFF |f 1.0€0KHZ

V2 - center
V1 - center
V1 - V2|

Cursor menu

B 4% A # ¥} 886-3-5753170
TR 17 L (1itE) 86-21-34970699
44 JH: 4% ) L (i 90) 86-755-83298787

Http://www. 100y. com. tw
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. . 4. Press the OSC OPTION key 0
Advanced Viewin gs repeatedly until the Time ®

Base menu appears.

Overview The advanced viewing functions allow you to \N o
clearly observe specific type of waveforms and/or <4/P _Time :/: : héﬁr;euﬁ?ie D
. . . . ¥4 N al g
particular characteristics in a waveform. A/VY _CursorVl BT
Viewing items ¢  Waveform zoom page45 (or Cursor V2)
o X-Y format paged?7 5. Use the arrow keys to change the zoom width.
» Signal peaks page48 Zoom out
« Noisy signals page48 vertical scale
» Variations in a signal page49
Narrow range D 0sC (l Wide range
] . OPTIO
Zooming waveforms horizontally
Overview By using the zoom function, you can magnify the fgontin
. . . . vertical scale
waveform in the horizontal direction.
Panel operations 1. Make sure that the waveform appears in the G\ Press F3 (Window) to zoga
display. into the window.
2. Press the MENU key and Q
select the TIME MODE menu Example
using the Up/Down keys. @ CHZ OFF |f 1.000KHZ
3. Press F2 (Set Window). A set
of cursors appears in the Window
center of the display.

Zoom window
CHZ OFF _f 1.000KHZ

B 4% H # # 886-3-5753170
W4 B~ (i) 86-21-34970699
4% ) HL - () 86-755-83298787

Http://www. 100y. com. tw
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Viewing waveforms in X-Y format

Overview

The X-Y format plots the CH1 input as X-axis and
CH2 input as Y-axis. This display mode is
convenient for viewing the phase relationship
between CH1 and CH2.

Panel operations

1. Make sure that both CH1 and CH2 waveforms
appear in the display.

2. Press the MENU key and Q

select the DISP SET menu

using the Up/Down keys. @
3. Press F3 (Format) and select
XY. The display mode Format

switches into the X-Y format.

Changing the
scale and
position

Press the OSC OPTION key
repeatedly to access the menu listed g
0

below. In the X-Y mode, all scales and %

positions are controlled by the
Up/Down keys. D

o CH1 Zero: horizontal position
o CH2 Zero: vertical position

« CH1 Vol: horizontal scale

« CH2 Vol: vertical scale

Functions not
applicable in the
X-Y format

The following functions do not work in the X-Y
format.

o Cursor measurement (page42, page43)
e Automatic measurement (page41)

»  Window zoom (page45)

o Trigger settings configuration (page25)

GYINSTEK

GDS-122 User Manual

Viewing signal peaks

Overview

Using the peak detect acquisition mode, the
maximum and minimum data in the sampling
interval are displayed, capturing the rapid
changes and sudden peaks that might
spontaneously occur in a waveform.

Note

Since the peak detect mode picks up the most
extreme data, the waveform becomes noisier than
the normal acquisition mode (sampling mode).

Panel operations

1. Press the MENU key and use the Up/Down
keys to select ACQU MODE menu.

2. Press F2 (Peak Detect) to activate the peak
detect mode.

Peak
ACQU MODE|

For other acquisition settings details, see page30.

NP

Example

Peak detect off

Peak detect on

F . < 3 . i ! 5 & L F E £ < : E .' £ £ E

48
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Viewing noisy signals Viewing variations in a signal
Overview Using the Average acquisition mode, you can Overview Using the persistence display function, you can
smooth out the displayed waveform by averaging define sets how long the old waveforms remain in
multiple data samples. The number of averaging is the display, allowing observation of waveform
selectable from 4, 16, 64, and 128. variations. You can select the persistence time
3 from 1, 2, and 5 sec. When choosing the Infinite
Note o Inorder for the average mode to work in the mode, the GDS-122 keeps all past traces of the

best way, the waveform must be repetitive. displayed waveform.

o As the number of averaging increases, the .
slower the waveform update becomes. Panel operations 1. Press the MENU key and use the Up/Down

keys to select DISP SET menu.

2. Press F2 (Persist) repeatedly to select the
persistence time.

Panel operations 1. Press the MENU key and use the Up/Down
keys to select ACQU MODE menu.

2. Press F3 (Average) to activate the average

Infinite
mode. Q 1/2/5 sec
3. Press F4 (Averages) repeatedly to select the @
number of averaging. Persist
: N
128
64 . . .
Q | For other display settings details, see page36.
1
@ Average {Avergges Example
v Persistence off Persistence infinite

For other acquisition settings details, see page30. SESERIEY| Gz OFF

| CHZ OFF

Example

Average off Average 16

CH1 -0.04 divs(-Z:0my)

- LEFT/RIGHT ~Tine Bagg -~ -
UE/DOUN ~CHL Yol = . o
CHL 50.0mse~ CHZ 100w

B 4% 1 # # 886-3-5753170
JEHE J7 B (ki) 86-21-34970699
Jik 4 h BG4I 86-755-83298787

Http://www. 100y. com. tw
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Calibration

Overview

The self calibration automatically adjusts the GDS-
122 internal parameters. The probe calibration
adjusts the probe capacitance. You should run
both whenever using the GDS-122 in a new
environment.

Running the self calibration

Overview

The self calibration function automatically
configures internal parameters to maintain the
sensitivity and accuracy. Run the self calibration in
the following cases.

When the temperature fluctuates more than 5
degrees Celsius during operations

When operating the GDS-122 in a new
benchtop or field environment

Procedure

. After removing all cables,
press F2 (Autocalibration) libration

Press the MENU key and Q
select the FUNCTION menu

using the Up/Down keys. @

Press F2 (Autocalibration). A
message appears on the libration
display, asking you to remove

all cables and probes from the
GDS-122.

again. The self-calibration
automatically starts and a
message appears, showing

GUWINSTEK GDS-122 User Manual

Running the probe calibration

Overview The attached probe contains a calibration point at
the end to adjust the waveform.
Procedure 1. You may use the GDS-122’s own
1kHz square wave output
signal. Insert the signal cable
(included in the package) to the 1

output terminal.

2. Use the Autoset function to put

the waveform in the middle of
the display.

f 1.005KHZ f 1.005KHZ
Fl - @ aINN3Y: TRIG NODH]

At

3. Adjust the probe calibration point to make sure
that the waveform edge remains flat.

B 4% H # # 886-3-5753170
JEHE J7 B (ki) 86-21-34970699
4% 1 LT (3 9I) 86-755-83298787

Http://www. 100y. com. tw

that the calibration is
ongoing.

. When the message disappears in 5 minutes, the

calibration is completed.

To interrupt
calibration

Press any key during the calibration.

51

Over- Optimum Under-
compensation compensation
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Saving/Recalling Waves and Settings

Overview The GDS-122 can save or recall four sets of
waveforms using its internal memory. When you
need to reset the system, recall the default (factory
installed) settings.

Save/recall items « Recalling default settings pageb3
o Saving waveforms pageb4
o Recalling waveforms page55

Recalling the default settings

Recalling the
default settings

You can recall the default factory settings by
pressing the MENU key, then selecting
FUNCTION — F1 (Recall Factory).

Recall
(o) (e
v (FD)

Trigger Type: Edge Slope: Rising
Source: CH1 Mode: Auto
Coupling: AC

CH1 & CH2 Coupling: AC Channel: ON
Probe scaling: 1 X Invert: OFF

Measurement 1 Item: CH1 frequency

Measurement 2 Item: CH2 frequency

Cursor Cursor: OFF Channel: CH1

Acquisition Mode: Sample Average number: 16

Time mode Mode: Main timebase

Display Type: Vector Persistence: OFF
Format: YT Carry: Bitmap

Wave Save Source: CH1 Waveform: A

Display: OFF

53
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Saving waveforms

Overview Up to four waveforms can be stored in and
recalled from the GDS-122 internal memory. The
stored waveform can be used for reference,
comparison, or analysis.

Memory Four memories: waveform A, B, C, and D.

Source CH1, CH2, Math waveform

Panel operations

54

1. Make sure the waveform you want to save
(CH1, CH2, or Math result) appears in the
display.

For Math operations details, see page39.

2. Press the MENU key and Q
select the WAVE SAVE menu
using the Up/Down keys. @

WAVE SAVE

3. Press F1 (Source) repeatedly CH1
and select the waveform Source
source.

4. Press F2 (WAVE) repeatedly A
and select the memory Wave
location from A to D.

5. Press F3 (Save) to confirm Save
saving the waveform into the

e

specified memory location. 3
Make sure that the message
“WAVE SAVED” appears in

the display.

Bk 4% 4 # 4 886-3-5753170
W4 B~ (i) 86-21-34970699
J: 4% 7 WL (5 9)1) 86-755-83298787

Http://www. 100y. com. tw
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Recalling waveforms

Overview Up to four waveforms can be stored in and
recalled from the GDS-122 internal memory. The
stored waveform can be used for reference,
comparison, or analysis.

Memory Four memories: waveform A, B, C, and D.

Source CH1, CH2, Math waveform

Panel operations 1. Press the MENU key and
select the WAVE SAVE menu

using the Up/Down keys. @

2. Press F2 (Wave) repeatedly
and select the waveform you Wave

GUWINSTEK GDS-122 User Manual

Menu Tree / Operation Shortcuts

Accessing The following menu trees are Q
menus accessible by pressing the MENU

key followed by Up/Down keys,

except for the OSC OPTION key

(=9
(page60). v

Trigger

.@ AC
Auto LF Rjc

Rising CH2 Normal HF Rjc
| | | |

Edge Falling CH1 Single DC
TRIG MQDE TYPE [ Slope ] Source ] Mode |Coupling

want to recall. B 4 __'H # 886-3-5763170 .
JUE %% J WL F- (i) 86-21-34970699 Inverted CH2 Field
3. Press F4 to turn on the Wk S B - (1) 86-755-83298787 { Video [ Normal ] CH1 ] Line ]
waveform. The Waveform Show T —— TYPE Polarity | Source Sync
appears in the display.
CHZ OFF CH1 OFF Select run or stop mode RUN/STOP key
y : Select edge or video trigger TRIG MODE—FI1(TYPE)

Select trigger slope TRIG MODE—F1(edge)—F2(Slope)
Select trigger source TRIG MODE—F1—F3(Source)
Select trigger mode TRIG MODE—F1(edge)—F4(Mode)
Select trigger coupling TRIG MODE—F1(edge)—F5(Coupling)
Select video polarity TRIG MODE—F1(video)—F2(Polarity)
Select video line sync TRIG MODE—F1(video)—F4(Sync)

CH1 2.00m-

CHL OFF [y

Note The recalled waveform maintains its original
horizontal scale and vertical scale, which are
shown in the top left corner of the display.
Changing the current scale does not affect the
recalled waveform'’s shape.

55

CH1/CH2 Setup

1000 X
CH1 SETUP DC 100 X
Ground  OFF 10X ON
| I ' '
AC ON 1X OFF
CH2 SETUP Coupling [ Channel ] Probe ] Inverted ]

Select AC, DC, or Ground coupling CH1/2 SETUP—F1(Coupling)

56
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Turn CH1 on or off

CH1/2 SETUP—F2(Channel)

Select probe scaling

CH1 /2 SETUP—F3(Probe)

Turn inversion on or off

CH1/2 SETUP—F4(Inverted)

Measurement Setup 1/2

CH2 CH2

CH1 CH1
| |

MEAS SET1

CH2 CH2 CH2
CH1 CH1 CH1
| | |

MEAS SET2 Freq | Period

Mean [ PK-PK ]Cyc RMS]

Measure CH1/CH2 frequency

MEAS SET1/2—F1(Freq)

Measure CH1/CH?2 period

MEAS SET1/2—F2(Period)

Measure CH1/CH2 mean value

MEAS SET1/2—F3(Mean)

Measure CH1/CH2 peak to peak time

MEAS SET1/2—F4(PK-PK)

Measure CH1/CH?2 cycle

MEAS SET1/2—F5(Cyc RMS)

Wave Math

WAVE MATHI— i1 —CH2’CH2—CH1 ’cm +CH2{CH1 *CHZJCH] /CH2’

Subtract CH2 from CH1

WAVE MATH—F1(CH1-CH2)

Subtract CH1 from CH2

WAVE MATH—F2(CH2-CHI1)

Add CH2 to CH1

WAVE MATH—F3(CH1+CH?2)

Multiply CH2 with CH1

WAVE MATH—F4(CH1*CH2)

Divide CH1 by CH2

WAVE MATH—F5(CH1/CH2)

Cursor Measurement

Time
Voltage CH2
1 1

CURS MEAS OFF CH1
Type Source

Activate cursor measurement

CURS MEAS—F1(Type)

Select source channel

CURS MEAS—F2(Source)

Bk 4% 4 # 4 886-3-5753170
W4 B~ (i) 86-21-34970699
4 1 B (1) 86-755-83298787 57
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Acquisition Mode

4
128
64
|

Peak 16
ACQU MODE Sample [ Detect ] Average ]Averages]

Select sampling mode ACQU MODE—F1(Sample)

Select peak detect mode ACQU MODE—F2(Peak Detect)

Select average mode ACQU MODE—F3(Average)

Select average number ACQU MODE—F3—F4(Averages)

Time Mode

Main Zone \
TIME MQRE TimeBase[ Window [ Window ’

Select main timebase TIME MODE—F1(Main TimeBase)

Set window zoom width TIME MODE—F2(Zone Window)

Zoom window TIME MODE—F3(Window)

Function

Recall | Autoca-
FUNCTION Factory [Iibration

Recall factory settings FUNCTION—F1(Recall Factory)

Run self calibration FUNCTION—F2(Autocalibration)

Display

Infinite
5 sec
2 sec
Dcl)ts 1 sec XY Vecltors

| |
Vectors
DISP SET Type

OFF ] YT Bitmap

Persist | Format Carry
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Select line display

DISP SET—F1(Type)

Select persistency

DISP SET—F2(Persist)

Select display format

Select display save format

(
(
DISP SET—F3(Format)
DISP SET—F4(Carry)

Wave Save

Math
CH2
|

D
C
B

ON
|

CHI1
WAVE SAVE Source l Wave

]
A

OFF
{ Save [ Show ]

Select source channel

WAVE SAVE—F1(Source)

Select waveform 1D

WAVE SAVE—F2(Wave)

Save waveform

WAVE SAVE—F3(Save)

Turn waveform display on or off

WAVE SAVE—F4(Show)

System Status

SYS STAT Horizontal

Vertical [Trigger { Misc ]

Show horizontal settings

SYS STAT—F1(Horizontal)

Show vertical settings

SYS STAT—F2(Vertical)

Show trigger settings

SYS STAT—F3(Trigger)

Show serial number

SYS STAT—F4(Misc)

GYINSTEK

GDS-122 User Manual

OSC OPTION key

UP Press the OSC OPTION key repeatedly. The
menu message appears in the lower half of

the display and the functionalities of four
LEFTD.GR'GHT keys, UP, DOWN, RIGHT, LEFT, change
accordmgly
DOWN E LEFT/RIGHT ~Tine Base-
AF/DOMN CHY Vol 5.0

o

LEFT/RIGHT - Ti . i iti

LT e me <4/P: CH1/CH2 horizontal position
J, A/ V' CH1 vertical position

0P DOWN ~ CHo vere 4/P>: CH1/CH2 horizontal position
J, A/V:CH2 vertical position

LEFT/RIGHT - Time <»

: CH1/CH2 horizontal position
J/ A/V. Trigger vertical position

UP/DOWN - Trig

LEFT/RIGHT - Time Base

UP/DOWN - CH1 Volts\Div /. horizontal scale

J/ A/ V. CH1 vertical scale

LEFT/RIGHT - Time Base
UP/DOWN - CH2 Volts/Div

—J

<4/W: horizontal scale
A/ V. CH2 vertical scale

(Math mode) (Math mode)

<4/» - Time <«/P: Math horizontal position
A /Y _CHMath A/ V¥ : Math vertical position
Volts/Div

(Cursor mode)
<4/» _ Time

A/VY _cCursor1/2

(Cursor mode)
</ CH1/CH2 horizontal position
A/ V: Cursor 1/2 vertical position

Bk 4% 4 # 4 886-3-5753170
W4 B~ (i) 86-21-34970699
J: 4% 7 WL (5 9)1) 86-755-83298787

Http://www. 100y. com. tw 59
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Using the Software

Overview

The GDS-122 PC software, included in the CD-

ROM, allows you to view the waveforms in your
familiar PC environment — large display and
mouse operation. Multiple cursors provide flexible
waveform measurements.

Software
functionalities

The PC software can run the following
measurement and actions.

Viewing real-time updated waveforms
Running up to 6 cursor measurements
Measuring period/frequency/pk-pk voltage
Printing out waveform images

Saving and recalling waveform shape and data

GYINSTEK

GDS-122 User Manual

Installing the software

PC requirements e
L]

Windows 2000 or XP
20MB hard drive space
USB host port x 1

Installation steps 1.

B 4% 1 # # 886-3-5753170

4% ) WL~ (B #) 86-21-34970699

Jl: 4% ) L (1) 86-755-83298787
Http:

www. 100y. com. tw

Software The following is the list of software operations
operations described in this chapter.
o Installing the software page62
» Modifying, reinstalling, or page64
uninstalling the software
o Connecting the GDS-122 page65
« Configuring the screen page68
o Viewing waveforms page69
e Measuring waveforms page75
» Saving waveforms page75
+ Recalling waveforms page77
o Printing out waveforms page80
o Accessing the Help page82
Note The PC software is intended for oscilloscope

operations only; it does not include multimeter
operations.

61
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Activate the Setup.exe file in the
CD-ROM.

A

setup.exe

The language selection window appears. Select
the software language and click OK (you can
later change the language manually).

Simplified Chinese

English

Cancel |

The software starts preparing the installation.
When the welcome window is displayed, click
Next and start installing the software to your
PC.

Welcome to the InstallShield Wizard for
DS_Wave

The InstalshieldR) Wizard wil alow you to modify, repair, or
remove DS_Wave. To continue, click Next.

= Bl

Cancel | |

The customer information window will appear.
Enter the user name and organization name.
Select which user will hold the right to access
the software and click Next.
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Customer Informmation
Flease enter your nformation, I‘~ -
Lksar hlame:

Joos: 12z e | > User Name
Crganization:
[pood Wi Tnstruments > Organization

Instal thes Iw ;

 anryons who uses this computer (all usars)

& Griy for me () Administration

5. Change the installation directory if necessary
and click Next.

Destination Folder

Click Mext to install to this folder, or click Change to install to a different folder, I -{.’ |

G Instal DS_Wave to:
C:¥Program Files¥GoodWil¥GDSs-122¥

< Back | [Mext > | Cancel | |

6. Click Install to start installing the software.

— InstallShie

¥ D el
Ready to Install the Program L
The wizard is ready to begin instalation. I d

Click Install to begin the installation.

If you want to review or change ary of your instalation settings, click Back. Click Cancel
o exit the wizard,

< Back I Install ZI Cancel | |

7. The software installation automatically starts
and ends. Click Finish to complete installation.

InstallShield Wizard Completed

The InstalShield Wizard has successfully installed DS_Wave.
Click Finish to exdt: the wizard.

= Back Finish Ganice] | |

Installing the software is completed
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Modifying/Reinstalling/Uninstalling the software

Overview After installing the software, you can do the
followings using the same setup file.

o Modifying the software components
» Repairing the software
o Uninstalling the software
Steps 1. Activate the Setup.exe. Follow g
the same procedures as "_
installing the software until the setupee

Program Maintenance window
appears.

Program Maintenance ‘

Modify, repair, or remove the program.

‘5-.

Change which program feafres are instaled. This optien displays the
@ Custom Selection dialog in which you can change the way features are

B 4% 5 # # 886-3-5753170 rricd

- fet - o g  Repair
H 1: ‘I-‘r }J i{-ln j’ [ [ ) ﬁH 8 b 2 ] 3497 0699 @ Repair \m';tal\anr?n ETOrs \néﬁe prograrm. This option fixes missing or
H’# lll‘" _}J i{_[. j’- [?‘\:{- U|” 8 6 ':.' 5 5 8 3 2 9 8 7 8 7 corrupt: fles, shortouts, and registry entries,
Http://www. 100y. com. tw © Remove

@ Remove DS_Wave from your computer.
C]

It

< Back I [ext > I Cancel

2. Select the action — Modify the software
components, Repair the software, or Remove
(uninstall) the software — and click Next.
Proceed according to the instructions.

Shortcut for Alternatively, you can select the Uninstall
uninstall DC_Wave from the program startup menu to
uninstall the software.

+ @ DE Wave exe

I E@ Hzlp documentation
B L

] USBDRV Install
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Activating the software and connecting the GDS-122

Overview Activate the software and connect the GDS-122 to
it properly by going through these steps,
described in the paragraphs that follow.

1. Activating the software and configuring the
communication port

2. Activating the GDS-122 and configuring the

GYINSTEK

GDS-122 User Manual

Activating the
GDS-122

data format W 4% 71 # # 886-3-5753170

3. Connecting them together and if necessary,

4. Acquiring waveform data to confirm that the Http:

W4 B~ (i) 86-21-34970699
installing the USB driver R ) L (5 1) 86-755-83298787

www. 100y. com. tw

communication is being secured

Activating the 1. Open the software by
software selecting DS_Wave.exe A B e
from the Startup menu. 3 Uninstall DS Wave

] USBDRV Install

2. Select Communications — Communications ~ Language

Ports Settings from the ports—settings
menu or click the Ports- Get Datg o NNPAHR
settings icon on the =

Toolbar.

Make sure that USB connection is being
selected. The baud rate, stop bit, data bit, and
parity settings are fixed.

Corkect uzsing: Im - l

= Settings

Bitz per zecond: m
Data bits: m
Paiity: m oK

Stop bits: m Cancel

Defaults

il

1.

Power up the GDS-122 and activate the
oscilloscope screen.

Connect an input signal to CH1 and make sure
that the waveform is shown appropriately on
the GDS-122 display.

Open the DISP SET menu and press F4 (Carry)
to select the format of the waveform data sent
from the GDS-122 to the software.

Q Vectors
Bitmap

@ (7

N

Vectors Vectored data of the waveform.
Always select the vector format when
viewing the waveform in the software.

Bitmap Bitmap image of the display. Select the
Bitmap format only when taking the
bitmap snapshot of the GDS-122
hardware screen.

Connecting the
cable

1.

Connect the GDS-122 to the PC (software) via
the USB cable.

Make sure that the USB driver is installed in
your PC by accessing the Device Manager
(Control Panel -> System -> Hardware tab). The
GDS-122 should be recognized as a USB hub.

Ei" USE (Universal Serial Bus?

‘% oscilloscope ush Board '

If the driver has not been  [[# ps wave.exe
recognized, install it I# Help documentation
manually by selecting (2} Uninstall DS Wave
USBDRV Install from the [FlE iy
startup menu.

The driver file is located in the USBDRYV folder
in the software directory.
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Acquiring data

Communications  Language

ports—settings

Get Data

In the software, select
Communications — Get Data
from the menu. Alternatively,
you may click the Getdata g
icon, or press the Ctrl + A =
key.

Acquiring the GDS-122 display snapshot

When the “Bitmap” format is selected in the GDS-
122 display carry setting, the software acquires the
display snapshot (*.bmp) at the moment. Save the
file in the local folder and use a graphic software
to open and edit it.

Acquiring the GDS-122 waveform
When the “Vectors” format is selected in the GDS-

122 display carry setting, the software acquires the
waveform data (*.bin) at the moment.

1. The waveform data will be stored in the PC
memory to allow to be recalled later (page79).
Edit the location and click Start.

w. Fils rsceive from LUSB ...

Receiving: |DD7DEDEH 339 bin

Storing & (IE ‘Progiam FileshDS_WwisWE dat\DOT03031 339 bin

Fie I [ I

B 4% 5 # #| 886-3-5753170
JHE 4R ) WL (i) 86-21-34970699
Ji: 4 T B (1) 86-755-83298787

Http:
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Configuring the screen

Overview

This section introduces how to configure the
following parameters in the software screen
(waveform viewing mode) to optimize the user
interface.

e Background color o Drawing format
o Grid color o Language
o Grid on/off o Closing the software

Screen overview

Tool bar
& Icons

Waveform
list
File

Cursor type

ch2 TimeBase

Horizontal
scale

Scdle Position

2505 =] Albje—

~ch2 Voltage
Positon
1|
[y [T

ch2

Period:  0.82mS
Frea: 1.213KHz
DD %60

Vertical scale

| Measurement
result

location

il
[E:7Program Fles/DS/WAVE/Dal/D06 10251417 .bin

o1z Model name

Changing the
background
color

www. 100y. com. tw

[F7roganm e/ O/ WAVE e/ DR 025 17 6m fosizz

Connecting the GDS-122 to the software is completed

67

To change the background color, [iew  Ferma: Comm:
select View > Background Color ¥ Wave ¥T
Data Tahkle

from the menu and select the
new color from the color palette
that appears. Alternatively, you
can also double click inside the
screen to call the color palette.

Grid Color

Black background White background

68
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Turning the grid To turn on or off the grid, select [iew Fermat Commi
on or off View > Grid lines from the menu ¥ Wave ¥T
or click the Gridlines icon. Derie Teble

Grid Celor
Background Color

v Grid lines

Grid on Grid off

Changing the ~ Make sure the grid is already View  Format
grid color turned on. Select View > Grid v Wave YT
Color from the menu and select Data Table

the new color from the color
palette that appears.

Blue grid

Changing the You can select how the waveform is being drawn
waveform from two formats, line and dots. Select Format >
drawing format Data Line (Point) from the menu or click the icons.

Line Point

Format Co Format Co
v Data Line . Data Line o
Data Point i’h.r'r-r' v Data Foint
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Changing the  You can select the language from English (default)

language or Simplified Chinese. Select Language > English
(Chinese) from the menu. The Language menu
itself always stays as English.

English Chinese
Langusge He Language —'
v English English
Chinese v Chinese

chl TimeBase — - chl KFHLil

Scale Position 2= fiig

[foous = M2l f[soous =]k
Closing the You can close the software in one of the following
software ways. The screen configurations will be retained

the next time you open the software.

o DPressing the Alt + F4 keys

o Selecting File > Exit from the Eile | Miew Fon
menu Open
Page Setup..

Print Preview
Print...
Printer Setup

» Clicking the Close icon at the
top right corner of the software L= 0 E

B 4 H # 4} 886-3-5753170

JHE 4% 7 ML (1 if8) 86-21-34970699

EAE J) HLF- () 86-755-83298787
Http:

www. 100y. com. tw
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Viewing the waveforms

Overview

This section introduces how to modify the
waveform settings for better viewings.

» Selecting the displayed waveforms

o Refreshing the waveforms

o Selecting the active waveform

o Changing the waveform positions

o Changing the waveform scales

o Viewing the automatic measurement results

Screen overview

Waveform
list

Types [Nore =

GYINSTEK

GDS-122 User Manual

Refreshing the
waveforms

Communications  Langu

ports—settings

In the software, select
Communications — Get Data
from the menu. Alternatively,
you may click the Get data icon,
or press the shortcut keys, Ctrl +
A.

Get Data

Selecting the
active waveform

B 4% 51 # # 886-3-5753170

JE4F 17 ML F-( i) 86-21-34970699

JEHF ) HL (5 41) 86-755-83298787
Http:

www. 100y. com. tw

ch2 TimeBase: .
Horizontal
scale

Scale Position

25005 = ]2t

ch2 Valtage

Scde  Postion
L]

5
ch2

Perio 0.82mS
Frea: 1,213 KHz
PK-PK: 2960 V

— Vertical scale

— Measurement
result

[e:7Program Fies/DS/WAVE/Dat/D06 10251417 bin

[pos-122

Active waveform

Selecting the
displayed
waveforms

In the left bottom corner of the screen, put a
checkmark in the waveform that needs to appear.
Maximum six waveforms are available: CH1, CH2,
A, B, C, D. Waveforms A to D have to be stored in
the GDS-122 hardware beforehand (see page54 for
details).

(CHT1, CH2 selected)

250uUs 2.00%

Ca 5 ns 2.00mi i1
Oe 5 ns 2.00my i1
Oc 5 1S 2.00mYy i1

71

Waveform scale settings and automatic
measurements are done on the active waveform.

1. Click on the waveform name in the bottom left
corner of the screen.

(CH1 selected as the active waveform)

25005

2,00

) 5 ns 2.00m i1
Oe 5 NS 2,00 i1
Oc 5 ns 2,00 i1

2. The following locations changes into the
selected channel (example: CH1).

rchl Cursor

¢ Colored channel label (at the
left side of the screen)

e Cursor, Time base, Voltage
settings (at the right side of

the screen) [-chl TimeBase ——

rchl Wioltage

« Automatic measurement gl -
. Period:  0.82mS
results (at the bottom right Freq: 1.213KHz
corner of the display) PK-PK:  13.200 W

Changing the
waveform
positions

72

Changing the horizontal position

1. Move the mouse over the waveform until the
mouse icon changes into a left-right arrow.

= =
\ - Mg
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2. Hold the mouse and drag the waveform Changing the vertical scale
sideways.

chi Yoltage

Select the vertical scale using

the list at the right side of the Scale POSiU'CiI
= L screen. You can select the scale | [FIFaEN
&> = either by searching in the Scale =
> colqmn or by clicking the 100 Y
Position arrows. 1200V

Scale Fos Scale Fos Scale Fos

Changing the vertical position

Click the channel label at the left side of the
waveform and drag the waveform up or down.

A
> K
Viewing the Before viewing the measurement results, make

automatic sure that the correct waveform is selected
Changing the Before changing the scales, make sure that the measurement (highlighted) in the lower left corner of the screen
waveform scales correct waveform is selected (highlighted) in the results (example: CH1).

lower left corner of the screen (example: CH1I).

2300U5

e EREW 7] ch2 25005 200V /1
¥ich2 25005 200V f1 DA A 2.00m@I NN 11
A 5 S 200mv 1
" " The measurement result chi
Changing the horizontal scale is updated in the lower Period: 0.82 mS
_ right corner of the :
Select the horizontal scale using | &t Timease screen. Three parameters ELE_%K 132 ;g DKGZ
the list at the right side of the Position are listed. : :
screen. You can select the scale FIIE]
either by searching in the Scale B o Period: measures the waveform period in ms.
column or by clicking the o Freq: measures the waveform frequency in
Position arrows. iticn KHz.
Scale Fos Scale Fos Scale Pos « PK-PK: measures the peak to peak voltage in V.

i .|
B 4% 5 # #| 886-3-5753170
JU 4 ) B (1) 86-21-34970699
JEHF ) HL (5 41) 86-755-83298787

Http://www. 100y. com. tw
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Using the cursor measurements

This section introduces how to use cursor
measurements in the software screen.

Overview

o Activating the cursors
» Viewing the cursor measurement results

o Moving the cursors

Screen overview

Vertical cursor

anguage Help

EeGEEEEE e

1: 364 N
S | Measurement

result
e 1,200.00

x1: 30000 uS
x2: 2100.00 _uS

Types [T |

Horizontal
cursor

— Cursor type

ch2 TimeBas
Scale Position

Fos =] 4l

ch2 Valtage
Scale Position

poov = j‘

chz
Period:  0.82mS
2:00m Freq: 1.213KHz

2.00mv
2.00my RIRK

|c /Program Flles/DS/\WAVE/Dat/ D06 102514 17.bin

2960V

[pos-122

Activating the
cursors

Before activating the cursors, make sure that the
correct waveform is selected (highlighted) in the
lower left corner of the screen (example: CHI).

25EIuS

chz 2,00V 1

Ca S ns 200mv f1
Select the cursors from the list in the right side of
the screen.

+ None: the cursor is turned off. s

« Horizontal: the horizontal
cursors appear.

Types

o Vertical: the vertical cursors

appear.

Types
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Types IM i |

o All: both the horizontal and
vertical cursors appear.

Viewing the
cursor
measurement
results

The cursor measurement rchl Cursor

results are updated in the dy 8.10

right side of the screen. vl 360 Y

o dy: the voltage difference |v2: -4.50 W
between y1 and y2 cursors

. ke 250,00

* y1, y2: voltage cursors 1 <1 25000 WS
and 2 X2 50000 uS

o dx: the time difference
between x1 and x2 cursors | Types IA" vl

e x1,x2: time cursors 1 and 2

B 4% 5 # #| 886-3-5753170
JH: 4% 7 WL (- #8) 86-21-34970699

Http://www. 100y. com. tw
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dy 0.0V— =

Moving the
cursors

76

Move the mouse over the cursor until the mouse
icon changes into a left-right arrow. Hold the
mouse and drag the cursor sideways (horizontal
cursor) or Vertlcally (vertical cursor)

The cursor measurement result Changes
accordingly.
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Saving waveforms

Overview

You can save the waveforms into the PC in two
ways. For details of recalling them, see page79.

o Storing waveform data (*.bin file, for viewing
in the software)

« Storing data points (*.txt file, for data analysis
such as in graphs and maps)

For details of storing waveforms into the GDS-122
hardware, see page54.

Storing
waveform data

When retrieving waveform data from the GDS-
122, the waveform data (*.bin format) is
automatically stored. For details, see page69.

Storing data
point

1. Make sure that the waveform is being
displayed in the screen. To recall waveforms
that are stored in the PC, see page79.

2. Select View > Data Table from the | wiew Format
menu, or click the Data Table v Wave YT
icon on the Toolbar. The Data Data Table
Table dialogue appears. STNIVA R

G o2l JAl IETED Jcii_Jpin =
w00 3440

500 3360 Units:(mv )
500 3440
500 3360
500 3440
500 3360 ~Save

ETR—T
IR
600 3440 P et
B o o .
FTR—T

- 2 Save option
R

-200 3360 Fc
ETR—T a2
o m

R
E—
TR
m

Save s +
-0 3440
Extt 1-

— Save data

200 3360
-0 3440
200 3360

ET—T 1]

+— Close window
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. Select the data to be saved from [ 3
the Save column. ol e
sequence: the identification | chi
number for each data point ¥ che
chl/ch2: CH1 and CH2 waveform | = &
data B
A/B/C/D: the waveforms stored W C
in the GDS-122 hardware ~ D
memory

GDS-122 User Manual

Data points stored in an Excel sheet (example)
sequence chl / ch2 A/B/C/D

f\J;WB IR

1 |Units:{ mv' )

2 chl /1 |ch2/1 A Bi1 Ci1 D/
3 1 -600 3440

4 2 -600 3360

5 3 -600 3440

5} 4 -600 3360

. Click the Save As... button to
save the data into a directory. The | =aV€AS ...
standard Save dialog appears.

. To close the Data Point dialogue, do one of the

following actions.
Press the Ctrl + Alt key

Click the Exit icon
Exit

Click the Close icon at the top
right corner of the dialogue ’

Bk 4% 4 # 4 886-3-5753170
W4 B~ (i) 86-21-34970699
J: 4% 7 WL (5 9)1) 86-755-83298787
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Recalling waveforms Printing out waveforms
Overview You can recall the waveforms from the PC in two Overview You can print out the screen contents to a printer
ways. For details of saving them, see page77. connected to the PC. When you are printing the

waveform for the first time, follow all the steps in

o Recalling waveform data (*.bin file, for viewing the following order

in the software)

« Recalling data points (*.txt file, for data 1. Setting up the printer

analysis such as in graphs and maps) 2. Setting up the page format
For details of recalling waveforms into the GDS- 3. Printing out
122 hardware, see page55. J )
Setting up the 1. Select File > Printer Setup File View For
Recalling the 1. Select File > Open from the | File Miew Format ( printer from the menu. The standard Cinen
waveform data menu or press the shortcut Open : printer setting dialogue R
key, Ctrl + O. opens. FPage Setup..
2. The File Open dialogue opens. Select one of the Erini Previzw
FIAT....

SPB bin file (*.bin) and click OK.

Printer Setup

3. The waveform(s) will be recalled in the screen.

2. Select the printer and its properties, paper size,
and orientation.

Language Help

\ Er©)

Setting up the 1. Select File > Page Setup from | Fjla  \fiew For
page format the menu. The Page Setup
dialog window opens.

Open

Types [tore ¥

ch2 TimeBase

Scale Position

i .
Borderline

[-ch2 voltage

SQCZZITE[SM% Topt® =] Bottomigl 10 cm
1 cm

2 —
Period: 082S Leftsa 1.0 'em Rights® I .

Om’/ / 1 Freg 1.213KHz
Som 11 2| [ Pepc 20e0v
[E:#Program Fies/DS/WAVE/Day/DOS 10251417 bin [pos—1z2 }l}}}: #%— jj ;%:j‘ 4". 886-3-5753170 View Settin i Gty
. . . WERE J) HLF- (1) 86-21-34970699 & Retian gph according to sample dat

Recalling the 1. For recalling the data points, you need to open J ‘tf_ 118 J’ ‘bl ’ = e - SR R
data points a text editor or a spreadsheet program like JEHE ) HL -G 41) 86-755-83298787 e s el

Excel, in which you can organize the data and Http://www. 100y. com. tw

create graphs and maps for advanced analysis. 0k | Concel | Defaut |

2. Open the saved *.txt file from the application.
2. Set the borderlines (print margins). The range

is 0 to 10.0cm each.
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3. Select the View Setting.

Redraw graph according to sample data:

The GDS-122 refreshes the waveform and
adjust its scale before printing. The most recent
data can be taken, but might take time for
refreshing.

Graph zoom in and out

The existing waveform is used with its scale
adjusted. Since retrieving the data is not
involved, fast printing is ensured.

4. Open the print preview by File Wiew For
selecting File > Print Preview
from the menu or clicking the
Print Preview icon on the
toolbar. Make sure that the
waveforms are placed

appropriately. @,

Open

FPage Setup..

Printing out

Print out the waveform in one of the following
ways.

o Selecting File > Print in the File  “iew
Print Preview screen menu Page Setup

o Selecting File > Print from the | File Wiew For

software menu O

Page Setup.
Print Prewiaw

o Pressing the shortcut keys, Ctrl + P

» Clicking the Printer icon on =
the Toolbar =

81
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Accessing the Help

Overview The Help file describes how to install and use the
software. The About screen shows the software
version.

Opening the Open the Help in separate file using one of the

Help following methods.

» Selecting Help > Help from the | Halg
mend Help  F1

About

» Clicking the Help icon on the @
Toolbar

o Pressing the shortcut key, F1

» Selecting the Help documentation from the
startup menu

’ E’fj DE_ave.exe

I? Help documentation
‘_’j Uninstall DS Wawe

Software version

82

To view the software version, Help
select Help > About from the " Help F1
menu. The software version

screen appears.

B 4 A # 3 886-3-5753170
WEHE 77 WL~ (1 iF) 86-21-34970699
J: 4% 7 WL (5 9)1) 86-755-83298787

Http://www. 100y. com. tw
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USING THE
MULTIMETER

This chapter describes the multimeter
functionalities in the GDS-122. Functionalities
includes three major items (Voltage, Current,
Impedance) and three additional items (Diode,
Continuity, Capacitance). The current
measurement and capacitance measurement use
extension modules to deal with large current and
small capacitance, respectively. Delta
measurement and automatic range switching
features offer flexibility and convenience.

Activating the Multimeter ......ccooviiiiiiiiiiiiii e 84
Measuring Voltage ..ccoeiuiiiiiiii e 85
Measuring CUMTeNt ...t i e aaaes 87
Measuring Impedance ......coooiiiiiiiiiii e 89
Measuring Diode ....ccoiiiiiiiiiii e 91
Measuring ContinUity ....oooiiiii i i e 92
Measuring CapacCitancCe ....ccceviiiiiiiei it i aaaas 93

Bk 4% 4 # 4 886-3-5753170
W4 B~ (i) 86-21-34970699
J: 4% 7 WL (5 9)1) 86-755-83298787

Http://www. 100y. com. tw
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Activating the Multimeter

Panel operations 1. Press the power switch. The
welcome screen with the corporate
logo appears on the display.

2. To adjust display brightness, use =
the switch on the side: up (bright) JA,E
or down (dark). =

3. Press any key (example: MENU  (Example)
key) to activate the display. The
battery icon at the top left corner of
the display shows the battery level.

> 75% 75% 50% 25% < 25%

P ®§ & 0 O

4. Press A (current), V (voltage), or R

(impedance, diode, continuity, -V
capacitance) switch to proceed. A
warning message might appear to R

remind you of correct connections.

NN oov B

(Press any key to make sure)

5. Press any key to cancel the warning message
and resume the measurement.

84
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Measuring Voltage

DC voltage Range 400mV, 4V, 400V

specifications A +(1% + 1 digit

(details: page98) ccuracy (1% igit)
Max input 400V

AC voltage Range 4V, 40V, 400V
specifications A +(1% + 3 digit
(details: page98) ccuracy (1% igits)
Max input 400V
Frequency 40Hz to 400Hz

Panel operations 1. Press the V switch to select the
Voltage measurement. If a warning  ya.
message appears, press any key to
resume measurement.

2. The voltage measurement screen appears.

Battery level — —— Run/Stop
Auto/Manual J -83.60mv Delt
elta
range ;— measurement
result
DCV/ACV —
Measurement
unit
Meter — Scaling factor
| Measurement
result
F1-F3 menu —

3. Press the AUTOSET key

repeatedly to select DC or AC
voltage measurement.

4. Connect the test leads to the (black) & (red)

terminals: Ay
COM for the black lead m\(,;;
V/Q/C for the red lead com V/Q/C

5. The measurement result will be constantly
updated in the display. For more detailed
settings, see the following instructions.

85
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Auto ranging To let the GDS-122 select the voltage
range automatically, press F3 (Auto).
The indicator at the top left corner of
the display changes to AUTO.

Manual ranging To select the voltage range manually,
press F1 (Manual). The indicator at the (1)
top left corner of the display changes @D
to MANUAL.

Freezing the To freeze the measurement, press the

measurement ~ RUN/STOP key. The measurement
result will be retained and the
indicator at the top right corner of the
display changes to STOP. To unfreeze,
press the RUN/STOP key again.

IHE@%

Measuring delta To measure the delta value, press F2
voltage (II/A). The measurement result at the
moment moves to the top right corner
of the display, and the measurement
result becomes the difference between
the original result.

1. Press F2 2. Measurement 3. Delta value

o

reset to zero displayed

|
oov
0 200.0v

o~

B 4% H # # 886-3-5753170
JEHE J7 B (ki) 86-21-34970699
4% 1 LT (3 9I) 86-755-83298787

Http://www. 100y. com. tw
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: 2. Select automatic range by
Measurin g Current pressing F3 (Auto) or manual
o by F1 (Manual). The indicator
DC current Range & 40mA (1% * 1 digit) at the top left corner of the
specifications  Accuracy 400mA =£(1.5% +1 digit) display changes accordingly.
(details: page98) 20A +=(3% + 3 digits)
Max input 400mA (direct input) Measuring 1. Connect the Current
20A (via the extension module) 400mA to 20A E’giﬂsgzon 2/(;:1}:18 i thle
m erminals.
AC current Range & 40mA =*(1.5% + 3 digits) & Then, connect the test leads
specifications ~ Accuracy 400mA *£(2% + 1 digit) to the extension module. ; i
(details: page98) 20A +=(5% + 3 digits) B 3 5 M # 886-3-5753170 AN
Max input 400mA (direct input) : (red) (black)

JEHE J7 B (ki) 86-21-34970699

20A (via the extention module)
W4 J B (581 86-755-83298787 | 2. Press F5 (20A) and select the 20A

Panel operations 1. Press the A switch to select the TR M S—. 20A range. The MANUAL
current (Ampere) measurement. If A range indicator activates.
a warning message appears, press (Auto range is not available)
any key to resume measurement. -
Freezing the To freeze the measurement, press the @
Battery level — — Run/Stop measurement ~ RUN/STOP key. The measurement ‘
Auto/Manual Delkd result will be retained and the
range ] | N surement 1I}d1cator at the top right corner of the
result display changes to STOP. To unfreeze,
DCA/ACA = press the RUN/STOP key again.
Measurement
unit Measuring delta To measure the delta value, press F2
Meter — Scaling factor current (II/A). The measurement result at the
moment moves to the top right corner
Measurement .
 result of the display, and the measurement
result becomes the difference between
F1-F5 menu — the original result.

1. Press F2 2. Measurement 3. Delta value

2. Press the AUTOSET key @ reset to zero displayed
repeatedly to select DC or - m 5 |
L
20.0mA

AC current measurement.

Measuring OmA 1. Connect the test leads to the (red) (black)

to 400mA terminals: @ jahy @
COM for the black lead MAX
mA/A for the red lead mA/AZe com

If the range is set at 20A,
press F4 (mA) and change it (72
to mA range.

20A—> mA
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: Manual ranging To select the voltage range manually,
Measurin g Im pe dance press F1 (Manual). The indicator at the

. top left corner of the display changes
Impedance Range & 4002 £(1% + 3 digits) to MANUAL.

specifications Resolution 4K, 40k, 400k, 4AMQ *(1% + 1 digit)

(details: page98) Freezing the To freeze the measurement, press the
Pee 40MQ *+(1.5% + 3 digits) g z u P l

measurement RUN/STOP key. The measurement
result will be retained and the
indicator at the top right corner of the
display changes to STOP. To unfreeze, $

Panel operations 1. Press the R switch. If a warning

message appears, press any key to g /* yC
resume measurement.

press the RUN/STOP key again. STOP
2. Press the AUTOSET key repeated]
to select the impedancey P X Measuring delta To measure the delta value, press F2
measurement. impedance (I/A). The measurement result at the
moment moves to the top right corner
3. The impedance screen appears. of the display, and the measurement
result becomes the difference between
Battery level — — Run/Stop the original result.
Auto/Manual _ Delta 1. Press F2 2. Measurement 3. Delta value
range p;gﬂfturement reset to zero displayed
Impedance
R PaN
Measurement 2 120.0kO

unit

3\\\\'.I|'.‘f_;/’
Meter — Scaling factor P

Measurement
result

F1-F3 menu

4. Connect the test leads to the (black) & (red)

terminals: 4
COM for the black lead ’ do0van =
V/Q/C for the red lead co 1Q/C

5. The measurement result will be constantly
updated in the display. For more detailed
settings, see the following instructions.

Auto ranging To let the GDS-122 select the voltage
range automatically, press F3 (Auto).
The indicator at the top left corner of
the display changes to AUTO.

B 4% 1 # # 886-3-5753170
JH: 4% ) (1 it5) 86-21-34970699
J: 4% 1 WL T (3 31) 86-755-83298787
89 90 Http://www. 100y. com. tw
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Measuring Diode

Range 0V to 1.5V

Panel operations 1. Press the R switch. If a warning

message appears, press any key to g /* QyC
resume measurement.

2. Press the AUTOSET key repeatedly

to select the diode measurement.

3. The diode measurement screen appears.

Battery level — =——+ Run/Stop

Manual range —

Diode —
Measurement
unit
Meter — Scaling factor
| Measurement
result
F1-F3 menu
(not used)

4. Connect the test leads to the (black) & (red)

terminals: 4y @
COM for the black lead m\(,;
V/Q/C for the red lead com V/Q/C

5. The measurement result will be constantly
updated in the display.

Freezing the To freeze the measurement, press the
measurement RUN/STOP key. The measurzment
result will be retained and the
indicator at the top right corner of the
display changes to STOP. To unfreeze,
press the RUN/STOP key again.

B 4% 1 # # 886-3-5753170

Ji: 4% ) W1 (Fitp) 86-21-34970699

JPE 4% 17 HLF-GRYIN) 86-755-83298787
Http://www. 100y. com. tw 91
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Measuring Continuity

Conditions <5002 (beeping)

Panel operations 1. Press the R switch. If a warning

message appears, press any key to g /* YC
resume measurement.

2. Press the AUTOSET key repeatedly

to select the continuity
measurement.

3. The continuity measurement screen appears.

Battery level — — Run/Stop
Manual range —
Continuity
Measurement
unit
Meter — Scaling factor
| Measurement
result
F1-F3 menu
(not used)

4. Connect the test leads to the (black) & (red)

terminals: Ay @
COM for the black lead ’ ﬁ’f;'; =
V/Q/C for the red lead co v/Q/C

5. If the GDS-122 confirms continuity (the
impedance is less than 50€2), the beeper
sounds.

Freezing the To freeze the measurement, press the @
measurement ~ RUN/STOP key. The measurement ‘
result will be retained and the
indicator at the top right corner of the ?
display changes to STOP. To unfreeze,
press the RUN/STOP key again.
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Measuring Capacitance

Continuity Range 51.2nF to 100uF % (3% + 3 digits)

specifications

Panel operations 1. Press the R switch. If a warning

message appears, press any key to @ /¥ yC
resume measurement.

2. Press the AUTOSET key repeatedly

to select the capacitance
measurement.

3. The capacitance screen appears.

Battery level —f o «—— Run/Stop

| 1.360nF
Auto range — i Delta
g — mealsurement
result
Capacitance
Measurement
unit
Meter Scaling factor
| Measurement
result
F1-F3 menu
(F1, F3 not —

used)

Measuring 5nF  Connect the test leads to the CX cami
and above terminals. 4o0v

J__ CX
Measuring less  Connect the Capacitance &
then 5nF Extension module to the COM @ 400V @
& V/Q/C terminals. Then,
& connect the test leads to the

extension module. The
measurement result will be
constantly updated in the
display.
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Freezing the
measurement

To freeze the measurement, press the @
RUN/STOP key. The measurement ‘
result will be retained and the

indicator at the top right corner of the

display changes to STOP. To unfreeze,
press the RUN/STOP key again. STOP

Measuring delta

capacitance

1. Press F2

To measure the delta value, press F2
(II/A). The measurement result at the
moment moves to the top right corner

of the display, and the measurement

result becomes the difference between

the original result.

2. Measurement 3. Delta value
reset to zero displayed

94
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video, is selected.

» Try changing the HF and LF repression in

the trigger coupling mode and filtering out
AQ high or low frequency noise.
No waveform in Q The waveform does not appear at all in the
the oscilloscope display.
Power Q « The GDS-122 does not power up.

A« The trigger level might be out of the
waveform range. Press the AUTOSET key
so that the GDS-122 automatically adjusts

» The GDS-122 stopped working after a short
period of time.

A The battery may need recharging. Connect the the trigger level.
GDS-122 to the AC adaptor and recharge it for « If the trigger mode is Single, press the
at least 15 minutes. Then try powering up. RUN/STOP key to trigger the waveform or
switch the trigger mode to Normal. See
ERR mode in the Q In the multimeter mode, the measurement page30 for trigger details.
multimeter type at the top of the display says “ERR”
which looks like an error message. Slow update in  Q It takes 30 to 40 seconds for the multimeter to
i the multimeter update the capacitor measurement.
A The “ERR” sign appears when none of the
measurement switch is pressed. Select one A It takes longer time to measure small
from the V, A, or R switch and press it. capacitors. 30 to 40 seconds are normal for
measuring 5nF or smaller capacitors. See
Amplitude Q The measured voltage is 10 times smaller than page93 for capacitance measurement details.
mismatch in the the real value.
oscilloscope ) ) : Slow update in  Q The display response to the waveform change
A The attenuation ratio on the probe is set at x10. the oscilloscope is unusually slow.
If you switch it to x1, make sure that the input
voltage does not surpass the maximum 400V. A Slow response is normal in the following
Q The measured voltage is 10/100/1000 times Az . . .
larger than the real value. » Average sampling mode is being selected
(page22)
A The probe ratio in the CHI or CH2 setup « Display persistence is being selected
menu is set at X10, X100, or X1000. See page22 (page36)
for details.
Unstable Q The waveform appears in the display but is
waveform in the not stable.
oscilloscope . .
A Configuring the trigger might help you. See
page30 for details.
o Make sure the trigger source channel
matches the inpu%%ignal. W 4% 71 # # 886-3-5753170
« Make sure the correct trigeer type, edge or JERE J) LS (1i5) 86-21-34970699

Jik 4 h BG4I 86-755-83298787

Http://www. 100y. com. tw
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SPECIFICATIONS

Conditions for  The following specifications are applicable when
specifications these two conditions are met:

o The GDS-122 has been powered up for at least
30 minutes, during which temperature
fluctuation is no more than 5 degrees Celsius.

o The probe attenuation is set to X 10.

Oscilloscope specifications

Sampling Mode Normal, Peak detection, Average
Rate 100 MSa/s
Input Coupling DC, AC
Impedance 1MQ=+2% in parallel with 20pF+3pF
Probe 1X, 10X, 100X, 1000X
Max. Input 400V (peak)
Channel delay 150ps (typical)
Horizontal Sampling rate 10S/s~100mS/s
Interpolation (sin x) /x
Record length 6K points on each channel
Scanning speed 5ns/div~5s/div, 1-2.5-5 step
Sampling rate / +100ppm (time interval = 1ms)
relay time accuracy
Interval (AT) Single: (1 interval time +100ppm X
accuracy (full reading+0.6ns) Average >16 : +(1
bandwidth) interval time +100ppm Xreading+0.4ns)
Vertical A/D converter 8 bits resolution (2CH simultaneously)
Sensitivity 5mV/div~5V/div (at input)
Displacement +50V(500mV~5V),=1V(5mV~200mV)
Bandwidth 20M
Single Full bandwidth
Low frequency >5Hz (at input, AD coupling, -3dB)
Rise time <17.5ns (at input, typical)
DC accuracy +5% (DC gain)

DC accuracy (avg) Avg >16: £(5% rdg + 0.05 div) for AV
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Trigger Sensitivity CH1 and CH2: 1div(DC~full bandwidth)
DC coupling: = 50Hz.
Trigger level +6 divisions from the screen center

Level accuracy
Displacement
50% level setting
Trigger sensitivity
Signal system

+0.3 div (typical, rise/fall time > 20ns)
655div (pre-trigger), 4div (post- trigger)
Input signal frequency > 50Hz (typical)
2 div of peak-to-peak (video trigger)
NTSC, PAL, SECAM (any frequency)

Measurement  Cursor AV and AT between cursors
Automatic Peak-to-peak, average, root mean
square, frequency, and cycle
Probe 1X position 10X position
Bandwidth < 6 MHz (DC) Full bandwidth (DC)
Attenuation rate 1:1 10: 1
Compensation 10pf~35pf 10pf~35pf
Input impedance 1MQ £2% 10MQ +2%
Input impendence 85pf~115pf 14.5pf~17.5pf
Input voltage 150 V DC 300V DC
Multimeter specifications
VDC Input impedance  10MQ
Max input 1000V (DC or AC peak-to-peak value)
Accuracy +1%+1 digit
Resolution 400mV range: 100uV
4V range: 1mV
40V range: 10mV
400V range: 100mV
VAC Input impedance  10MQ
Max input 750V(AC, virtual value)
Frequency range = 40Hz~400Hz
Display Virtual value of sine wave
Accuracy +1%+£3 digits
Resolution 4V range: 1TmV
40V range: 10mV
400V range: 100mV
DCA Accuracy 40mA range: =1%+1 digit
400mA range: £1.5%+1 digit
20A range: +3%+3 digits
Resolution 40mA range: 10uA
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400mA range: 100uA
20A range: 10mA

ACA

Accuracy

Resolution

40mA range: +1.5%+3 digit
400mA range: +2 %+ 1 digit
20A range: +5%+3 digits
40mA range: 10uA

400mA range: 100uA

20A range: 10mA

Resistance

Accuracy

Resolution

400Q range: +1%+3 digits
4kQ~4MQ range: =1%+1 digit
40MQ range: £1.5%+1 digit
400Q range: 0.1Q

4kQ range: 1Q

40kQ range: 10Q

400kQ range: 100Q

4MQ range: 1kQ

40MQ range: 10kQ

Capacitance

Accuracy
Resolution

+3%+3 digits
51.2nF range: 10pF
512nF range: 100pF
5.12uF range: 1nF
51.2uF range: 10nF
100uF range: 100nF

Diode

Reading range

0V~1.5V

Continuity

Threshold

General specifications

< 30Q

Display Type 3.8" color liquid crystal display
Resolution 320 (horizontal) X240 (vertical) pixels
Color 4096 colors
Power Consumption < 6W
Supply 100V~240V AC, 50/60Hz
DC input 8.5VDC, 1500mA
Environment Operating Temperature: 0 to 40 °C(32 to 104 °F)
Relative humidity: < 75%
Storage Temperature: -20 to 60 °C(-4 to 140 °F)
Relative humidity: < 75%
Mechanical Dimension 18 cmx11.5cmx4cm
Weight 6909
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DECLARATION OF
CONFORMITY

We

GOOD WILL INSTRUMENT CO., LTD.

(1) No.7-1, Jhongsing Rd., Tucheng City, Taipei County, Taiwan

(2) No. 69, Lu San Road, Suzhou City (Xin Qu), Jiangsu Sheng, China
declare, that the below mentioned product

Type of Product: Handheld Digital Storage Oscilloscope & Multimeter

Model Number: GDS-122

is herewith confirmed to comply with the requirements set out in the
Council Directive on the Approximation of the Law of Member States
relating to Electromagnetic Compatibility (89/336/EEC) and Low Voltage

Directive (73/23/EEC).

For the evaluation regarding the Electromagnetic Compatibility and Low
Voltage Directive, the following standards were applied:

© EMC

Current Harmonics
EN 61000-3-2: 2000 + A2:2005

EN 61326-1: Electrical equipment for measurement, control and laboratory
use — EMC requirements (1997 + A1:1998 + A2:2001 + A3:2003)

Voltage Fluctuations
EN 61000-3-3: 1995 + A1:2001

© Safety

Safety Requirements

IEC/EN 61010-1: 2001 (2nd Edition)

Low Voltage Equipment Directive 73/23/EEC
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ACA multimeter

AC-DC adaptor

ACV multimeter .........cccceveeuriecnnnne
addition, math mode.......cccocvene...

impedance multimeter

voltage multimeter
auto trigger mode
AUTO trigger status
automatic measurements .

capacity multimeter
continuity, multimeter
diode, multimeter
impedance measurement
voltage multimeter
average acquisition mode

background color, PC software
capacitance measurement,

carry, interface setting

caution symbol

channel
edge trigger .....cooerervererrecrercnnns 31
ON/Off oo 23
video trigger source ...........ccc...... 34
contents of package.........cccoeuveuriunnes 10
continuity, multimeter...................... 92
specifications
coupling
system status.........cooeeeriieiiiennnne 38
HIGEeT oo 32
vertical ..o, 24
cursor measurement
PC software .......cccoeeeeeiecieineinnnes 75
ShOTt CUtS..cooeici e 57

voltage..
cycle rms, automatic measurement 41
data point, storing .... 77
data table, PC software..................... 77
DC coupling

HIGEeT v 32

vertical ..o, 24
DCA multimeter .........c.ccocveureuninnnns 87

specifications........c.coeeuevviririinines 98
DCV multimeter .........ccoooeururiueinnnnns 85

specifications.........c.cccoeuevviecieiinnnns 98

default settings
delta measurement

capacitance multimeter ............... 94

current multimeter-...................... 88

impedance multimeter ................ 90

voltage multimeter.........ccccc...... 86
diode measurement, multimeter..... 91

specifications.........cccoouevevrcriinnnes 99
display

acquiring snapshot...........cccc.......

brightness adjustment

OVETVIEW ..oviviieririenieeneeeeeerenaennes
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SEttINGS ..o, 36
shortcuts.......coevievicicicicicnin 58
specifications........c.ccocvuveriricnnnes 99
division, math mode.........c.cccveuvn.. 39
dot drawing .......cceeeevvicrriiccrricnennne. 36
edge trigger......cocovvvicrnicneiininns 30
auto mode.......ccooerevviniiniciiinnnn 31
coupling mode........c.ccocvririnnnnns 32

normal mode.

single mode ... .32
EN61000 ....oouivrrerereeieiereieeeins 100
EN61010

declaration of conformity.......... 100

measurement category .................. 7

pollution degree..........cccccvuurrrunnnnee 7
ENG61326-1 ..o 100
environment

operation.........cooueveueieveicnieieiiennnns 7

specifications. .99

StOTAZE ..evviiiiei e 8
ERR mode, multimeter ..................... 95
extension module

capacitance multimeter................ 93

current multimeter...................... 88

package ... 10
factory settings.........ccooevvvcerriciennee. 53
FAQ..eecceec e 95

ERR mode, multimeter. .95

magnification .............. .95

no waveform . .96

POWETING UP ...vvnerieiirieiiaiene 95

slow update, multimeter............. 96

slow update, oscilloscope............ 96

unstable waveform...........cccc....... 95
field trigger, video.......ccccevuevrinnunnee. 34
freezing measurement

capacitance multimeter................ 94

continuity multimeter.................. 92

current multimeter. .88

diode multimeter-...........cccouruune 91

impedance multimeter ................ 90

voltage multimeter..............c........ 86
frequency, automatic measurement41
front panel overview..........ccccoceuuue. 12
grid color, PC software...........ccc...... 69
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grid, PC software..........ccccocveuviuruninns 69
ground symbol...........cccoeeiiniiiinnnns 6
help, PC software .........cccecovuvueunnnee 82
HE RJC oo 32
horizontal
adjusting position................... 20, 25
adjusting scale.......cc.cccoceunuene 19, 26
scale vs trigger status................... 28
short cuts................ ...58
specifications.. .97

system status......... .37
impedance, multimeter.................... 89

specifications..........ccccocueeuvierininnnes 99
installing PC software........c.ccccocoeuue. 62
inverting channel..........ccccccoovuennnnee 24
language

PC software ........cccccvvicuvincnnecnee. 70

ShOTt CULS...ocveieiie 58
LE RJC.oiiiiiieiiiieieisiciesiceniians 32
line data, PC software... .69
line trigger, video .........cccocrurieencnans 34
list of features........c.ccccecuevveeuricrccnecnnes 11
magnification, vertical....................... 25
manual ranging

current multimeter..................... 88

impedance multimeter ................ 90

voltage multimeter...........cc......... 86
manual, overview of ..........cccccceeueueas 14
math mode............... .39

shortcuts... .57

system status .......ccceeveriiieiinnnns 38

mean voltage, auto measurement... 41
multimeter

activating ..o, 84
capacitance measurement........... 93
continuity measurement ............. 92
current measurement.................. 87
diode measurement...................... 91
ERRmode ..o, 95
impedance measurement............ 89
specifications...........ccceueuecurierininns 98
voltage measurement................... 85
Warning message.........ocovoveueueuenns 84
multiplication, math mode .............. 39
noisy signal, viewing ...........cccccceeuue. 49
normal trigger mode..........cccoeuvunnnne 32
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oscilloscope setting attenuation...........cccceeuu. 17
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cursor measurement .... .75 waveforms from GDS-122.... 55
help ..o .82 waveforms, PC software .. 79
installation ... .62 resetting trigger level... 29
OVEIVIEW oottt 61 TUN tHZZeT .o 28
PaCKage ... 10 sample acquisition mode.................. 35
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saving waveform...........ccccoeeeueee 77 ShOTECULS...covveercieeciae 59
SCIeen OVEIVIeW .........cccceveeeeverecnens 68 waveforms in PC software.......... 77
uninstall ... 64 waveforms inside GDS-122 ........ 54
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viewing waveforms..........c.c......... 71 horizontal.........cccooveviuviniciricnnnnce. 26
peak detect acquisition mode........... math mode.. 40
application.........cceeevviciiiininnnns vertical ..., 23
period, automatic measurement..... 41 waveform, PC software............... 73
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pk-pk voltage, automatic Scan trigger status ..........cccoceevevnnenen. 27
Measurement........coceveeevreeuevcnnns 41 self calibration.........ccoeveevviiucininnnes 51
point data, PC software.................... 69 SET1/2, automatic measurement..... 41
position signal peak, viewing ...........ccccocc.... 48
horizontal........ccooeiriienieinicn, 25 single trigger mode .. 32
math mode... .40 slope, trigger........... 30
shortcuts.... .60 snapshot, display ... 67
HMe CUTSOT .....cvieerierieiieiiiae 43 software Version ...........cc.cceeeeueiunne. 82
HIGEeT vt 28 specifications
vertical......cooveniciicce 23 general......coovivcrnnicinic 99
voltage CUrsor........cooovevvincueincnnn. 44 multimeter ... 98
waveform, PC software............... 72 oscilloscope........ccoevviiiriinininnen 97
XY MO 47 StOP trigger ..o 28
power supply STOP trigger status .......cccccevuvurunnee. 27
safety instructions ............cceeeunnee 7 storage environment ..............cceeeueuene. 8
specifications... . subtraction, math mode......... 39
POwWer up, faq....ccoeeveivcireininiciinnns synchronization, video trigger-........ 34
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adjusting display magnification 17 threshold, continuity multimeter.... 92
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Trig'd trigger status......
trigger
adjusting level..........
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specifications............
status icons ...............
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USB driver installation
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vertical
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